Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right amount of service for any size organization
■ Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
■ Upgrade assurance that delivers software upgrades
■ Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

■ Product release level
■ Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

- Asia-Pacific and Japan: customercare_apac@symantec.com
- Europe, Middle-East, and Africa: semea@symantec.com
- North America and Latin America: supportsolutions@symantec.com
Special installation guidelines for HP-UX systems .......................... 34
Special installation guidelines for UNIX clustered environments ......................... 34
How the installation script works .............................................................. 35
About mounting the NetBackup software media ...................................... 36
Mounting NetBackup software media on UNIX or Linux systems ................. 37
Installing NetBackup master server software on UNIX .............................. 38
Continuing with NetBackup software installation ...................................... 44
Installing NetBackup media server software on UNIX .............................. 44
About pushing client software from a master server to clients ......................... 48
Installing client type software on a master server ...................................... 49
Installing NetBackup add-on products ...................................................... 50
How to configure the window manager for the Java Interface
(NetBackup-Java compatible platforms) ...................................................... 50

Chapter 4 Installing server software on Windows systems .............. 52
Requirements for Windows NetBackup server installation ......................... 52
About the NetBackup preinstallation Environment Checker ......................... 55
Running the preinstallation Environment Checker ........................................ 56
Requirements for Windows cluster installations and upgrades ......................... 58
Performing local, remote, or clustered server installation on Windows systems .......................................................... 60
Post-installation tasks for NetBackup cluster environments ......................... 72
Verifying Windows cluster installations or upgrades ..................................... 73
Installing NetBackup servers silently on Windows systems ......................... 73

Chapter 5 Installing administrative interface .................................. 76
About the NetBackup Remote Administration Console ......................... 76
Installing the NetBackup Remote Administration Console ......................... 76
Configuring server lists for the NetBackup Remote Administration Console .......................... 78
Adding remote servers to administer from an existing NetBackup Remote Administration Console ............................................ 79
About the NetBackup Administration Console .......................................... 80
Installing the NetBackup Java Administration Console ......................... 80
Installing or removing multiple versions of the NetBackup-Java Administration Console on Windows ............................................ 80
Installing multiple versions of the NetBackup-Java Administration Console on Windows ............................................ 81
Removing earlier versions of the NetBackup-Java Administration Console on Windows ............................................ 82
Chapter 6 Installing NetBackup client software .................. 83
  About NetBackup client installation .................................. 83
  About NetBackup client installation on Windows .................. 84
    About Windows client installation methods and requirements .... 84
    Installing NetBackup Windows clients locally or remotely .... 87
    Installing NetBackup Windows clients silently ................. 93
    How to configure NetBackup clients .............................. 94
  About NetBackup client installation on UNIX/Linux ............... 95
    About UNIX/Linux client installation methods ................. 97
    Installing UNIX clients locally .................................. 98
    About remote installation methods for UNIX/Linux clients .. 100
    Adding a UNIX/Linux client after initial server installation .. 106
    Upgrading clients after servers are upgraded ................... 108

Chapter 7 Configuring NetBackup ........................................ 112
  About NetBackup startup and shutdown scripts ................... 112
  About NetBackup server configuration .............................. 114
    Starting the NetBackup Administration Console .................. 116
    About the Device Configuration Wizard ........................... 117
    About the Volume Configuration Wizard ........................... 119
    About the Catalog Backup Wizard ................................ 120
    About the Backup Policy Configuration Wizard ................... 121

Chapter 8 Upgrading NetBackup software .............................. 123
  About upgrading NetBackup ........................................... 123
  About the NetBackup 7.x Upgrade Portal ............................ 123

Chapter 9 Removing NetBackup server software ...................... 125
  About NetBackup server software removal on UNIX systems ...... 125
  Removing NetBackup from UNIX servers ............................ 126
  About NetBackup server software removal on Windows systems ... 135
  Removing NetBackup server software on Windows systems ....... 135
  Removing NetBackup server software in a clustered environment .. 138
  Removing NetBackup LiveUpdate from Windows systems ......... 138
  About removal of the Java Console state data from Windows servers and Windows clients ............................. 139

Chapter 10 Removing NetBackup client software ..................... 140
  About NetBackup software removal on UNIX/Linux clients ....... 140
  Removing NetBackup from UNIX/Linux clients ..................... 140
Chapter 11
Reference

About the NetBackup Java Runtime Environment
Using NetApp disk arrays with Replication Director
Security updates to the NetBackup database

Index
Preparing for installation

This chapter includes the following topics:

- Restrictions on the NetBackup installation directory
- About compatibility between NetBackup versions
- About Symantec Operations Readiness Tools
- Recommended SORT procedures for new installations
- Recommended SORT procedures for upgrades
- About NetBackup software availability
- About storage device configuration
- How to install NetBackup
- About security certificates for NetBackup media servers

Restrictions on the NetBackup installation directory

Each NetBackup supported file system defines restrictions on file and folder names for the installation folder. Please consult the file system vendor provided documentation for more details on the file and the folder name restrictions. Additionally, NetBackup supports only certain characters for the installation folder name. Use of non-supported characters can produce unexpected results and possibly result in lost data. The NetBackup supported characters for the installation folder are:

- UNIX/Linux
  The POSIX fully portable file name characters (A–Z a–z 0–9 . _ -)
- Windows
  The printable characters within the ASCII 7-bit range
About compatibility between NetBackup versions

You can run mixed versions of NetBackup between master servers, media servers, and clients. This back-level support lets you upgrade NetBackup one server at a time, which minimizes the effect on overall system performance. Symantec supports only certain combinations of servers and clients. The NetBackup catalog resides on the master server. Therefore, the master server is considered to be the client for a catalog backup. If your NetBackup configuration includes a media server, it must use the same NetBackup version as the master server to perform a catalog backup.

For complete information about compatibility between NetBackup versions, see the NetBackup Release Notes for version 7.7.

http://www.symantec.com/docs/DOC8512

Symantec recommends that you review the End of Support Life information available online.

http://www.symantec.com/docs/TECH74757

See “About NetBackup software availability” on page 18.

About Symantec Operations Readiness Tools

Symantec Operations Readiness Tools (SORT) is a robust set of standalone and web-based tools that support Symantec enterprise products. For NetBackup, SORT provides the ability to collect, analyze, and report on host configurations across UNIX/Linux or Windows environments. This data is invaluable when you want to assess if your systems are ready for an initial NetBackup installation or for an upgrade.

Access SORT from the following webpage:

https://sort.symantec.com/netbackup

Once you get to the SORT page, more information is available as follows:

- Installation and Upgrade Checklist
Use this tool to create a checklist to see if your system is ready for a NetBackup installation or an upgrade. This report contains all the software and the hardware compatibility information specific to the information provided. The report also includes product installation or upgrade instructions, as well as links to other references.

- **Hot fix and EEB Release Auditor**
  Use this tool to find out whether a release that you plan to install contains the hot fixes that you need.

- **Custom Reports**
  Use this tool to get recommendations for your system and Symantec enterprise products.

- **NetBackup Future Platform and Feature Plans**
  Use this tool to get information about what items Symantec intends to replace with newer and improved functionality. The tool also provides insight about what items Symantec intends to discontinue without replacement. Some of these items include certain NetBackup features, functionality, 3rd-party product integration, Symantec product integration, applications, databases, and the OS platforms.

Help for the SORT tools is available. Click **Help** in the upper right corner of the SORT home page. You have the option to:

- Page through the contents of the help similar to a book
- Look for topics in the index
- Search the help with the search option

### Recommended SORT procedures for new installations

Symantec recommends new NetBackup users perform the three procedures that are listed for an initial introduction to SORT. The tool has many other features and functions, but these serve as a good introduction to SORT. In addition, the procedures provide a helpful base of knowledge for other SORT functionality.

<table>
<thead>
<tr>
<th>Table 1-1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Procedure</strong></td>
<td><strong>Details</strong></td>
</tr>
<tr>
<td>Create a SymAccount profile on the SORT webpage</td>
<td>See “To create a SymAccount profile on the SORT page” on page 13.</td>
</tr>
<tr>
<td>Create generic installation reports</td>
<td>See “To create a generic installation checklist” on page 13.</td>
</tr>
</tbody>
</table>
To create a SymAccount profile on the SORT page

1. In your web browser, navigate to:
   https://sort.symantec.com/netbackup

2. In the upper right corner, click **Register**.

3. Enter the requested login and contact information:
   - **Email address**: Enter and verify your email address
   - **Password**: Enter and verify your password
   - **First name**: Enter your first name
   - **Last name**: Enter your last name
   - **Company name**: Enter your company name
   - **Country**: Enter your country
   - **Preferred language**: Select your preferred language
   - **CAPTCHA text**: Enter the displayed CAPTCHA text. If necessary, refresh the image.

4. Click **Submit**.

5. When you receive your login information, you can log into SORT and begin uploading your customized information.

To create a generic installation checklist

1. In your web browser, navigate to:
   https://sort.symantec.com/netbackup

2. Find the **Installation and Upgrade Checklist** widget.
3 Specify the requested information

<table>
<thead>
<tr>
<th>Product</th>
<th>Select the appropriate product from the drop-down menu. For NetBackup select <strong>NetBackup Enterprise Server</strong> or <strong>NetBackup Server</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product version you are installing or upgraded to</td>
<td>Select the correct version of NetBackup. The most current version is always shown at the top of the list.</td>
</tr>
<tr>
<td>Platform</td>
<td>Select the operating system that corresponds to the checklist you want generated.</td>
</tr>
<tr>
<td>Processor</td>
<td>Select the correct processor type for your checklist.</td>
</tr>
<tr>
<td>Product version you are upgrading from (optional)</td>
<td>For new installations, do not make any selections. For upgrades, you can select the currently installed version of NetBackup.</td>
</tr>
</tbody>
</table>

4 Click **Generate Checklist**.

5 A checklist corresponding to your choices is created. You can modify your selections from this screen, and click **Generate Checklist** to create a new checklist.

You can save the resulting information as a PDF. Numerous options are available for NetBackup and many of them are covered in the generated checklist. Please spend time reviewing each section to determine if it applies to your environment.

To create a system-specific installation report for Windows

1 Go to the SORT website:
   [https://sort.symantec.com/](https://sort.symantec.com/)

2 Select **SORT > SORT for NetBackup**

3 In the **Custom Reports Using Data Collectors**, select the **Data Collector** tab.

4 Select the radio button for **Graphical user interface** and download the correct data collector for your platform.

   The data collector is OS-specific. To collect information about Windows computers, you need the Windows data collector. To collect information about UNIX computers, you need the UNIX data collector.

5 Launch the data collector after it finishes downloading.
On the **Welcome** screen, select **NetBackup** from the product family section and click **Next**.

On the **System Selection** screen, add all computers you want analyzed. Click **Browse** to see a list of computers you can add to the analysis. Symantec recommends starting the tool with an administrator or a root account.

When all systems are selected, review the **System names** section and click **Next**.

In the **Validation Options** screen, under **Validation options**, select the version to which you plan to upgrade.

Click **Next** to continue.

The utility performs the requested checks and displays the results. You can upload the report to My SORT, print the results, or save them. Symantec recommends that you upload the results to the My SORT website for ease of centralized analysis. Click **Upload** and enter your My SORT login information to upload the data to My SORT.

When you are finished, click **Finish** to close the utility.

To create a system-specific installation report for UNIX or Linux

1. Go to the SORT website:
   
   https://sort.symantec.com/

2. Select **SORT > SORT for NetBackup**

3. Change to directory that contains downloaded utility.

4. In the **Custom Reports Using Data Collectors**, select the **Data Collector** tab.

5. Download the appropriate data collector for your platform.
   
   The data collector is OS-specific. To collect information about Windows computers, you need the Windows data collector. To collect information about UNIX computers, you need the UNIX data collector.

6. Run **./sortdc**
   
   The utility performs checks to confirm the latest version of the utility is installed. In addition, the utility checks to see it has the latest data. The utility then lists the location of the log file for this session.

7. If requested, press **Enter** to continue.

8. Select the **NetBackup Family** at the **Main Menu**.
9 Select Installation/Upgrade report when prompted What task do you want to accomplish?
You can select multiple options by separating your response with commas.

10 Specify the system or systems you want included in the report.
If you previously ran a report on the specified system, you may be prompted to run the report again. Select Yes to re-run the report.
The utility again lists the location of the log files for the session.
The progress of the utility is displayed to the screen.

11 Specify NetBackup when prompted for the product you want installation or upgrade reports.

12 Enter the number that corresponds to the version of NetBackup you want to install.
The utility again lists the location of the log files for the session.
The progress of the utility is displayed to the screen.

13 The utility prompts you to upload the report to the SORT website if you want to review the report online. The online report provides more detailed information than the text-based on-system report.

14 When your tasks are finished, you can exit the utility. You have the option to provide feedback on the tool, which Symantec uses to make improvements to the tool.

Recommended SORT procedures for upgrades
Symantec recommends current NetBackup users perform the three procedures that are listed for an initial introduction to SORT. The tool has many other features and functions, but these serve as a good introduction to SORT for users who already use NetBackup. In addition, the procedures provide a helpful base of knowledge for other SORT functionality.

Table 1-2

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a SymAccount profile on the SORT webpage</td>
<td>See “To create a SymAccount profile on the SORT page” on page 13.</td>
</tr>
</tbody>
</table>
### Table 1-2 (continued)

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a system-specific upgrade report</td>
<td>See “To create a system-specific installation report for Windows” on page 14.</td>
</tr>
<tr>
<td></td>
<td>See “To create a system-specific installation report for UNIX or Linux” on page 15.</td>
</tr>
<tr>
<td>Review the future platform and feature plans.</td>
<td>See “To review future platform changes and feature plans” on page 17.</td>
</tr>
<tr>
<td>Review the hot fix and emergency engineering binary release auditor information.</td>
<td>See “To review hot fix and emergency engineering binary information” on page 17.</td>
</tr>
</tbody>
</table>

#### To review future platform changes and feature plans

1. In your web browser, navigate to:
   https://sort.symantec.com/netbackup

2. Find the **NetBackup Future Platform and Feature Plans** widget.

3. Click **Display Information**.

4. Review the information provided.

5. Optional - sign in to create notification - Click **Sign in and create notification**.

#### To review hot fix and emergency engineering binary information

1. In your web browser, navigate to:
   https://sort.symantec.com/netbackup

2. Find the **NetBackup Hot Fix and EEB Release Auditor** widget.

3. Enter the hot fix or emergency engineering binary (EEB) information.

4. Click **Search**.

5. The new page shows a table with the following columns:

   - **Hot fix of EEB Identifier**: Shows the hot fix or EEB number that was entered on the previous screen.
   - **Description**: Displays a description of the problem that is associated with the hot fix or EEB.
   - **Resolved in Versions**: Provides the version of NetBackup where this issue is resolved.
About NetBackup software availability

NetBackup 7.7 is available in the following formats:

- DVD media kit
  All necessary software and documentation files are provided on several DVDs. See “About the NetBackup media kit” on page 18.

- Electronic Software Distribution (ESD) images
  The DVD image files are posted and available for download on the FileConnect website. See “About the NetBackup Electronic Software Distribution (ESD) images” on page 19.

About the NetBackup media kit

The media kit includes a DVD for each supported UNIX platform or operating system and one DVD for Windows. The label on each DVD provides a brief description of its contents. Printed materials in the kit include a copy of the NetBackup Getting Started Guide.

Table 1-3 describes the contents of each DVD.

<table>
<thead>
<tr>
<th>Platform OS</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX 64-bit</td>
<td>Server and supported options</td>
</tr>
<tr>
<td>HP-UX IA64</td>
<td>Server and supported options</td>
</tr>
<tr>
<td>Linux RedHat x86_64</td>
<td>Server and supported options</td>
</tr>
<tr>
<td>Linux SUSE x86_64</td>
<td>Server and supported options</td>
</tr>
<tr>
<td>Solaris SPARC64</td>
<td>Server and supported options</td>
</tr>
<tr>
<td>Solaris x86-64</td>
<td>Server and supported options</td>
</tr>
<tr>
<td>Windows</td>
<td>Server and supported options</td>
</tr>
<tr>
<td></td>
<td>All x64 clients</td>
</tr>
<tr>
<td></td>
<td>All x86 clients</td>
</tr>
<tr>
<td>Linux zSeries RedHat x64</td>
<td>Media server and supported options</td>
</tr>
<tr>
<td>Linux zSeries SUSE x64</td>
<td>Media server and supported options</td>
</tr>
<tr>
<td>Platform OS</td>
<td>Contents</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>UNIX clients 1</td>
<td>■ AIX</td>
</tr>
<tr>
<td></td>
<td>■ FreeBSD</td>
</tr>
<tr>
<td></td>
<td>■ HP PA-RISC and IA64</td>
</tr>
<tr>
<td></td>
<td>■ Mac</td>
</tr>
<tr>
<td></td>
<td>■ Solaris SPARC and X86</td>
</tr>
<tr>
<td>UNIX clients 2</td>
<td>All Linux platforms</td>
</tr>
<tr>
<td>Clients in LiveUpdate format 1</td>
<td>■ AIX</td>
</tr>
<tr>
<td></td>
<td>■ HP IA64</td>
</tr>
<tr>
<td></td>
<td>■ All Linux platforms</td>
</tr>
<tr>
<td></td>
<td>■ Solaris SPARC and X86</td>
</tr>
<tr>
<td>Clients in LiveUpdate format 2</td>
<td>■ HP PA-RISC</td>
</tr>
<tr>
<td></td>
<td>■ FreeBSD</td>
</tr>
<tr>
<td></td>
<td>■ Mac</td>
</tr>
<tr>
<td></td>
<td>■ All Windows platforms</td>
</tr>
<tr>
<td>OpsCenter for Windows</td>
<td>All Windows platforms</td>
</tr>
<tr>
<td>OpsCenter for UNIX/Linux</td>
<td>All UNIX/Linux platforms</td>
</tr>
<tr>
<td>OpenVMS (CD format)</td>
<td>NetBackup Client for OpenVMS</td>
</tr>
</tbody>
</table>

See “About the NetBackup Electronic Software Distribution (ESD) images” on page 19.

## About the NetBackup Electronic Software Distribution (ESD) images

The ESD images for NetBackup 7.7 are available for download from the FileConnect webpage. The images adhere to a 1.8G size limitation.

To ensure the accuracy of the ESD download, some of the product images have been split into smaller, more manageable files. Before you uncompress any file, you must first join the split image files that you can identify as 1 of 2 and 2 of 2. A Download Readme.txt file on FileConnect describes how to join the files together.

See “About NetBackup software availability” on page 18.

See “About the NetBackup media kit” on page 18.
About storage device configuration

Reliable use of NetBackup depends on the proper configuration of your storage devices. To ensure reliable backups and restores, you must first install and configure devices to work with the operating system.

Before you install NetBackup, use the following guidelines to configure storage devices to work with the operating system:

New installations

Before you install NetBackup, Symantec recommends that you install and configure your devices with the latest version of drivers.

Connections and settings

To prepare and connect new devices, perform the following tasks:

- Set the SCSI ID (target). Make sure that it is set to an available SCSI ID.
- Physically attach your device to a compatible host bus adapter where that SCSI ID is available.
  Compatible means that both the device and the host bus adapter are of the same type. For example, single-ended, high-voltage differential, low voltage differential, or Fibre Channel.

Configuration

To configure storage devices to work with the operating system, refer to the following documentation:

- The instructions from the device and the operating system vendors.
- The NetBackup Device Configuration Guide. See the chapter that is appropriate for your operating system. http://www.symantec.com/docs/DOC5332

NetBackup installation

After all storage devices are installed, configured, and verified to work with the operating system, you can install NetBackup.

Warning: An improperly configured device can lead to backup failures, data loss, or both.

See “About NetBackup server installation requirements for UNIX/Linux systems” on page 31.

See “Requirements for Windows NetBackup server installation” on page 52.
Locating supported robot types

You can find a list of the supported robot types in the *Hardware Compatibility List (HCL)*.

For your convenience, Symantec periodically updates this document on the Symantec support website

To find the latest robot types that this release supports

◆ Click on the following link to access the *Hardware Compatibility List (HCL)*:
  
  http://www.netbackup.com/compatibility

How to install NetBackup

For new NetBackup installations, install the software in the following order:

Step 1  Install master server software.
Step 2  Install media server software (NetBackup Enterprise only).
Step 3  Install the NetBackup Remote Administration Console (optional).
Step 4  Install client software.
Step 5  Install any NetBackup add-on products (such as language packages).

Before you proceed with any installation procedure, be sure to review the installation requirements.

**Note:** NetBackup supports software system management standards. To support software system management standards, NetBackup installs two XML files on each NetBackup host. These files do not affect NetBackup functionality. In addition, you can identify these files by the suffix .swidtag.

See “Requirements for Windows NetBackup server installation” on page 52.

See “About NetBackup server installation requirements for UNIX/Linux systems” on page 31.

About the NetBackup preinstall checker

Starting with NetBackup 7.6, the server installer for both the UNIX/Linux and the Windows platforms includes a new preinstall checker. This feature helps to determine if your server is ready for a successful installation or upgrade.
Note: This feature is different than the NetBackup preinstallation Environment Checker that was released with the Windows version of NetBackup 7.1.

The check runs automatically when you start an installation on a master or a media server. The results of the check are shown at the following point:

- UNIX/Linux upgrade script
  After you answer the question for participation in the NetBackup Product Improvement Program.

- Windows installation wizard
  On the Ready to Install the Program screen, where the Installation Summary appears.

One of the tests that is performed is a comparison of the locally installed Emergency Engineering Binary (EEB) updates with the fixes included with the version of NetBackup being installed. If any of the preinstall tests fail, a message appears to indicate what type of action is required.

Some test failures are considered minor and let you continue with the installation or the upgrade. Critical test failures prevent the installation or the upgrade from happening. The output informs you that other action must be taken before you can proceed safely with the installation or the upgrade.

The preinstall check results are stored in the following locations:

- UNIX
  In the installation trace file in the following path:
  /usr/openv/tmp

- Windows
  In the following directory:
  %ALLUSERSPROFILE%\Symantec\NetBackup\InstallSummary\%


About the NetBackup Product Improvement Program

Starting with NetBackup 7.5, the NetBackup Product Improvement Program captures installation deployment and product usage information.

During the NetBackup installation, you can choose to participate in the NetBackup Product Improvement Program and send this information automatically and securely to Symantec. The information that Symantec receives becomes part of a continuous quality improvement program that helps understand how customers configure, deploy, and use the NetBackup product. This information is then used to help
Symantec identify improvements in product features, testing, technical support, and future requirements.

To learn more about the NetBackup Product Improvement Program, refer to the NetBackup license agreement section 17.18 Data Collection; Data Protection Regulations. The following describes where to find the license agreement:

- **UNIX**
  In the base directory of the UNIX images on the DVD media or from the downloaded media images from FileConnect, see the file LICENSE.

- **Windows**
  From the DVD media or the downloaded media images from FileConnect, start the installation wizard (Browser.exe). On the Home page, click Installation. On the Installation page, select either **Server Software Installation** or **Client Software Installation**. On the Welcome page, click Next to advance to the License Agreement page.

---

**About security certificates for NetBackup media servers**

NetBackup requires that media servers have a digital security certificate so that they function correctly in the following use cases:

**NetBackup Administration Console authorization for Enhanced Auditing**

In the Enhanced Auditing mode, a security certificate is mandatory when a user wants to connect to a media server through the **NetBackup Administration Console**. See the **NetBackup Security and Encryption Guide**:

For cloud storage

The NetBackup CloudStore Service Container requires that a certificate be installed on the media server. If one is not installed, the Service Container cannot start.

See the **NetBackup Cloud Administrator’s Guide**:

For the procedure to generate security certificates for media servers, see the **NetBackup Administrator’s Guide, Volume I** or the **NetBackup Cloud Administrator’s Guide**:

http://www.symantec.com/docs/DOC5332
About NetBackup license key requirements

To install NetBackup master server or media server software, you must enter a NetBackup product license key.

To obtain license keys, you must order a license SKU when you order your NetBackup products.

After you place your order, Symantec sends you an email with a license certificate that includes the following information:

- **List of NetBackup licenses purchased**
  - This list includes all of the licenses for the products that you ordered.
  - Keep this list in a secure location. You may be asked for a product license key if you ever need to contact technical support for assistance.

- **Serial number for access to download NetBackup products**
  - Instead of a DVD media kit, you can use this serial number to download the Electronic Software Distribution (ESD) images for NetBackup product installation.
  - Go to the following website and enter this serial number to download the ESD images to your system:
    - [https://fileconnect.symantec.com/LangSelection.jsp](https://fileconnect.symantec.com/LangSelection.jsp)
When you install NetBackup, Symantec recommends that you enter all other product license keys on the master server when you are prompted. Although you can add these license keys later, it is easier to enter them when you install the master server software.

For detailed information on how to administer NetBackup license keys, refer to the *NetBackup Administrator’s Guide, Volume I.*

http://www.symantec.com/docs/DOC5332

**About NetBackup license compatibility**

To use your current NetBackup license keys to upgrade servers, add-on products, and database agents to NetBackup 7.7, the following are required:

- NetBackup versions 6.x or 7.0.x must already be installed.
- You must have a valid maintenance contract for all licensed NetBackup products.

*Note:* You cannot upgrade to NetBackup 7.7 if your current installed version is NetBackup 5.x. You must first upgrade to NetBackup 6.0 or 6.5, and then you can upgrade to NetBackup 7.5. Any 6.x version can be upgraded directly to 7.7.

Upgrade licenses and software may be obtained from the Symantec Licensing Portal at the following website:

https://licensing.symantec.com/acctmgmt/index.jsp

For detailed information and procedures on how to administer license keys, refer to the *NetBackup Administrator’s Guide, Volume I.*

http://www.symantec.com/docs/DOC5332

See “About license key entry” on page 25.

**About license key entry**

License keys for all NetBackup SKUs must be entered on the master server. License keys for some SKUs must also be entered on the media server, depending on the capabilities that you require for the media server.

**Table 2-1** describes the license keys that must be entered on each server.
### Table 2-1 Required license keys for NetBackup media servers

<table>
<thead>
<tr>
<th>Media server type</th>
<th>Required licenses (based on media server capabilities)</th>
</tr>
</thead>
</table>
| Enterprise media servers | - NetBackup Enterprise Server 7.7 UNIX  
- NetBackup Enterprise Server 7.7 WIN/LNX/SOLX64  
- NetBackup Standard Infrastructure 7.7 XPLAT1 Front End TBYTE  
- NetBackup Enterprise Infrastructure 7.7 XPLAT1 Front End TBYTE  
- NetBackup Platform Base  
- NetBackup Option Library Based Tape Drive 7.7 XPLAT  
- NetBackup Option Shared Storage Option 7.7 XPLAT  
- NetBackup Option NDMP 7.7 XPLAT  
- NetBackup Media Server Encryption Option for Enterprise Server, UNIX  
- NetBackup Media Server Encryption Option for Enterprise Server, Windows/Linux |
| SAN media servers       | - NetBackup Enterprise Client, UNIX  
- NetBackup Enterprise Client, Windows/Linux  
- Media Server Encryption Option for SAN Media Server (Enterprise Client), UNIX  
- Media Server Encryption Option for SAN Media Server (Enterprise Client), Windows/Linux |

Enter license keys by using one of the following methods:

- During NetBackup master server and media server installation (recommended)
  The installation script prompts you to enter the license keys for all NetBackup products that you plan to install.

- NetBackup Administration Console
  After NetBackup master server or media server installation, open the console and click **Help > License Keys**.

- Command-line interface (UNIX only)
  After NetBackup master server or media server installation, use the following command:

  `/usr/openv/netbackup/bin/admincmd/get_license_key`
Note: You can log on to a NetBackup server from almost any server in a system to view, enter, and administer license keys. When you administer license keys remotely, make sure that you view the licenses of the system you intend to change. You do not want to add or change a license key on the wrong server.

Frequently asked questions about license keys

Symantec customers have asked the following questions about how to manage license keys.

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the license system for NetBackup the same as the license system in other Symantec products?</td>
<td>NetBackup uses a common license system that other Symantec products also use. Please remember, however, that the common license system provides flexibility in the license features that each product implements. For example, NetBackup does not have a node-locked license system, but some other products do.</td>
</tr>
<tr>
<td>Can I use NetBackup if all I have is a media kit?</td>
<td>No. The media kit by itself does not allow any access to NetBackup. You always need a license key (either permanent or evaluation). License keys should always be delivered with the media kit, so you should never find yourself with a media kit and no key.</td>
</tr>
</tbody>
</table>
| What does the license key look like? What information does it contain?   | The key is a multi-digit alphanumeric string (for example: 8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-OIUF-AJDC). The key contains information on the following:  
  - Whether the key is for NetBackup Server or NetBackup Enterprise Server  
  - Whether the key is for a server, a client, an agent, or an option (and which one)  
  - Whether the key is a permanent key or an evaluation key  
  - Information about how and where the key was generated |
<p>| Is the license key serialized?                                           | Yes, serialization information is embedded in the key. |</p>
<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can I see reports on what license keys I have?</td>
<td>Yes. Information about license keys is stored on the master server. To access the information, open the NetBackup Administration Console and select Help &gt; License Keys. On UNIX servers, you can also run the following command: /usr/openv/netbackup/bin/admincmd/get_license_key For more information on how to view reports, refer to the NetBackup Administrator’s Guide, Volume I. <a href="http://www.symantec.com/docs/DOC5332">http://www.symantec.com/docs/DOC5332</a></td>
</tr>
<tr>
<td>How do I enable options and agents?</td>
<td>When you install NetBackup, you are prompted to enter the license keys for all options and agents. If you purchase an agent or other add-on product at a later date, you can enter its license key manually. Open the NetBackup Administration Console and select Help &gt; License Keys. On UNIX servers, you can also run the following command: /usr/openv/netbackup/bin/admincmd/get_license_key Some options require that you have your original NetBackup DVDs, because additional binaries must be installed. You should always keep your NetBackup DVDs in a safe place.</td>
</tr>
<tr>
<td>Should I save license keys after they have been entered?</td>
<td>Yes. Always store copies of your license keys in a secure place.</td>
</tr>
<tr>
<td>What should I do if I have lost my license key(s)?</td>
<td>Symantec has a record of all license keys that are issued to customers. Customers who lose their license key(s) can call Order Management to get copies of their license keys. If you have purchased NetBackup from a Symantec partner, you need to contact that partner for information on your key.</td>
</tr>
</tbody>
</table>
|                                                                         | ▪ For Americas, Japan, PacRim, Australia: 650.318.4265 FAX: 650.335.8428  
▫ For Europe, Middle East and Africa: 00.353.61.365232 FAX: 00.353.61.365223 |
<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>How are large volume orders handled?</td>
<td>Many NetBackup installations are very large, and the license keys are long. License keys that you enter multiple times can be time-consuming. You can request a single license key for each type of NetBackup component you purchase. For example, you can obtain one license key for use with 50 Oracle agents. Site licenses enable unrestricted use for specific NetBackup agents or options. You still need a unique license key for each type of NetBackup component that you purchase. Separate license keys are required for components like NetBackup Server, a Lotus Notes agent, or any NDMP option.</td>
</tr>
<tr>
<td>What about license keys for customers with site licenses?</td>
<td>Site licenses are handled much like large volume orders are. The certificate for a site license states that the license key is good for unlimited copies.</td>
</tr>
<tr>
<td>Do I need a license key to enable NetBackup Remote Administration Consoles?</td>
<td>No. NetBackup Remote Administration Consoles do not require special license keys. You can install them on any computer with access to the master server.</td>
</tr>
<tr>
<td>Can a license key be used multiple times?</td>
<td>Yes. You can use your license keys multiple times. You are, however, legally bound to install and use only the number of NetBackup servers, clients, agents, and options for which you purchase licenses.</td>
</tr>
<tr>
<td>How do existing customers get license keys?</td>
<td>All NetBackup customers who have current maintenance contracts with Symantec automatically receive the latest version of NetBackup. You receive the NetBackup media kit and license keys for every component for which you purchased licenses. If your maintenance is through a Symantec partner, you upgrade through the partner. Contact the partner for more details.</td>
</tr>
<tr>
<td>What if I do not get the right license keys?</td>
<td>If you believe that you received an incorrect license key, contact Order Management using the number on your license key certificate. Technical support does not issue permanent license keys. You can obtain license keys only through Order Management. Technical support can provide temporary one-month license keys to you while issues regarding permanent license keys are resolved.</td>
</tr>
<tr>
<td>What does an evaluation license key enable?</td>
<td>The evaluation license key enables unrestricted use of NetBackup, its agents, and its options for a predetermined period of time.</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Am I notified when an evaluation is about to expire?</td>
<td>To find out when a license key expires, open the NetBackup Administration Console and select <strong>Help &gt; License Keys</strong>. On UNIX servers, you can also run the following command: <code>/usr/openv/netbackup/bin/admincmd/get_license_key</code></td>
</tr>
<tr>
<td>What happens when an evaluation license key expires?</td>
<td>The NetBackup services or daemons are shut down. When you attempt to use the product you are informed that its evaluation period has expired.</td>
</tr>
<tr>
<td>Does NetBackup save the backup configuration and catalog information when evaluation license keys expire?</td>
<td>Yes. Customers who add a permanent license key to an evaluation version of NetBackup have immediate access to their catalog information and configuration information.</td>
</tr>
<tr>
<td>How do I upgrade from an evaluation license to a permanent license?</td>
<td>It is easy. When you purchase a permanent license, you add that license to NetBackup. All the configuration information and catalog data from your evaluation version is retained. To enter your permanent license key, open the NetBackup Administration Console and select <strong>Help &gt; License Keys</strong>. On UNIX servers, you can also run the following command: <code>/usr/openv/netbackup/bin/admincmd/get_license_key</code></td>
</tr>
</tbody>
</table>
Installing server software
on UNIX systems

This chapter includes the following topics:

- About NetBackup server installation requirements for UNIX/Linux systems
- How the installation script works
- About mounting the NetBackup software media
- Installing NetBackup master server software on UNIX
- Installing NetBackup media server software on UNIX
- About pushing client software from a master server to clients
- Installing NetBackup add-on products
- How to configure the window manager for the Java Interface (NetBackup-Java compatible platforms)

About NetBackup server installation requirements for UNIX/Linux systems

Before you install NetBackup, make sure that your backup environment meets the following requirements:
Table 3-1

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General requirements</td>
<td>Make sure that you have the following hardware and software already set-up:</td>
</tr>
<tr>
<td></td>
<td>■ All NetBackup installation DVDs or ESD images, appropriate license keys, and the root password for all servers.</td>
</tr>
<tr>
<td></td>
<td>■ The <code>gzip</code> and the <code>gunzip</code> commands must be installed on the local system. The directories where these commands are installed must be part of the root user’s <code>PATH</code> environment variable setting.</td>
</tr>
<tr>
<td></td>
<td>■ A server of a supported hardware type that runs a supported version of its operating system (with applicable patches), adequate disk space, and supported peripherals. For details on these requirements, refer to the NetBackup Release Notes.</td>
</tr>
<tr>
<td></td>
<td>■ All NetBackup servers must recognize and be recognizable by their client systems. In some environments, this means that each must be defined in the other’s <code>/etc/hosts</code> file. Other environments may use the Network Information Service (NIS) or Domain Name Service (DNS).</td>
</tr>
<tr>
<td></td>
<td>■ For reasonable performance of the NetBackup-Java interfaces, you need 512 MB of RAM. Of that space, 256 MB must be available to the interface program (<code>jnbSA</code> or <code>jbpSA</code>).</td>
</tr>
<tr>
<td></td>
<td>■ The minimum screen resolution configuration is 1024x768, 256 colors.</td>
</tr>
<tr>
<td>Other backup software</td>
<td>Symantec recommends that you remove any other vendor backup software currently configured on your system before you install this product. Other vendor backup software can negatively affect how NetBackup installs and functions.</td>
</tr>
<tr>
<td>Media servers</td>
<td>Ignore references to media servers if you do not plan to install any separate media servers.</td>
</tr>
<tr>
<td>Memory considerations</td>
<td>■ Master servers in a production environment with several database agents enabled, should have a minimum of 8 GB of memory each.</td>
</tr>
<tr>
<td></td>
<td>■ Media servers in a production environment should have a minimum of 4 GB of memory each.</td>
</tr>
<tr>
<td></td>
<td>■ Any client in a production environment should have a minimum of 512 MB of memory.</td>
</tr>
<tr>
<td></td>
<td>■ For reasonable performance of the NetBackup-Java interfaces, you need 512 MB of RAM. Of that space, 256 MB must be available to the interface program (<code>jnbSA</code> or <code>jbpSA</code>).</td>
</tr>
<tr>
<td></td>
<td>■ For additional information about memory requirements, refer to the NetBackup Backup Planning and Performance Tuning Guide. <a href="http://www.symantec.com/docs/DOC5332">http://www.symantec.com/docs/DOC5332</a></td>
</tr>
</tbody>
</table>
Table 3-1 (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space considerations</td>
<td>On the NetBackup server, the installation directory contains the software and the NetBackup catalog. Both of these can become quite large.</td>
</tr>
<tr>
<td></td>
<td>If space is an issue, you can install NetBackup on an alternate file system. The installation lets you select an alternate install location, and creates the appropriate link from /usr/openv.</td>
</tr>
<tr>
<td></td>
<td>For additional information about disk space requirements, refer to the NetBackup Getting Started Guide.</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.symantec.com/docs/DOC5332">http://www.symantec.com/docs/DOC5332</a></td>
</tr>
<tr>
<td>NFS compatibility</td>
<td>Symantec does not support installation of NetBackup in an NFS-mounted directory. File locking in NFS-mounted file systems can be unreliable.</td>
</tr>
<tr>
<td>Kernel reconfiguration</td>
<td>For some peripherals and platforms, kernel reconfiguration is required. For more details, see the NetBackup Device Configuration Guide.</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.symantec.com/docs/DOC5332">http://www.symantec.com/docs/DOC5332</a></td>
</tr>
<tr>
<td>Red Hat Linux</td>
<td>For Red Hat Linux, NetBackup requires server networking.</td>
</tr>
</tbody>
</table>

Do not mix non-English versions of Windows and UNIX platforms unless master and media servers are NetBackup appliances

Do not mix non-English versions of Windows and UNIX platforms unless your master servers and media servers are NetBackup appliances. If you mix non-English versions of Windows and UNIX platforms, differences in operating system architecture and encodings may cause non-ASCII file names and folder names to display incorrectly within the user interface. This issue may cause functional failures.

NetBackup installations on environments that run different versions of UNIX-based operating systems

NetBackup can be installed in environments that run different versions of UNIX-based operating systems as long as the system locales are identical. The use of different locales across UNIX platforms may cause non-ASCII file names and folder names to display incorrectly within the user interface. This issue may cause functional failures.
Special installation guidelines for Solaris systems

Several kernel-tunable parameters, such as Message Queue, Semaphore, and Shared Memory Parameters, can affect NetBackup performance. If you adjust these values, you may prevent your system performance from slowing down or even reaching a deadlock state.

More information about tunable parameters is available online.

- Recommended NetBackup *NIX semaphore tuning values (Linux/Solaris/HP-UX/AIX)
  http://www.symantec.com/docs/TECH203066
- Tuning Solaris 10 for NetBackup
  http://www.symantec.com/docs/TECH63229
- Tuning Solaris 10 shared memory for NetBackup Media Server processes (bptm / bpdm)
  http://www.symantec.com/docs/TECH62633
  While this link refers to NetBackup 6.x, the information remains valid for NetBackup 7.x.

For more information about parameter definitions and examples, see the NetBackup Backup Planning and Performance Tuning Guide on the support website.

http://www.symantec.com/docs/DOC5332

Special installation guidelines for HP-UX systems

Use the following guidelines when you install NetBackup on HP-UX systems:

- Install NetBackup on a file system that supports long file names.
- During NetBackup installation, the following error may occur when the NetBackup database is created:

  SQL error (-832) -- Connection error: Insufficient system resources – failed to allocate a SYSV semaphore

  To correct the error, increase the number of semaphores in the HP-UX kernel.

  For details on how to change HP-UX parameters, see the NetBackup Backup Planning and Performance Tuning Guide, Chapter 11: OS-Related Tuning Factors.

  http://www.symantec.com/docs/DOC5332

Special installation guidelines for UNIX clustered environments

Use the following guidelines when you install NetBackup in clustered systems:
■ Ensure that each node in the NetBackup cluster can run the `rsh` command or its equivalent (on HP-UX, the command is `remsh`). Starting with NetBackup 7.5, you can also use the `ssh` command. The root user must be able to perform a remote login to each node in the cluster without entering a password. This remote login is necessary for installation and configuration of the NetBackup server and any NetBackup options. After installation and configuration are completed, it is no longer required.

■ You must install, configure, and start the cluster framework before you install NetBackup. For additional installation prerequisites and installation notes, see the NetBackup Clustered Master Server Administrator’s Guide. http://www.symantec.com/docs/DOC5332

■ You must have defined a virtual name using DNS, NIS, or `/etc/hosts`. The IP address is defined at the same time. (The virtual name is a label for the IP address.) Use this virtual name and IP address only for the NetBackup resource.

How the installation script works

When you install NetBackup server software, client software is also installed. When you install NetBackup 7.7, the following options are also installed if the platform supports them:

■ BMR Master Server
■ NDMP
■ Symantec Product Authentication and Authorization (NetBackup Access Control)
■ Vault
■ BMR Boot Server
■ DB2
■ Encryption
■ Informix
■ LiveUpdate agent
■ Lotus Notes
■ Oracle
■ SAP
■ Snapshot Client
■ Sybase
After installation is complete, a valid license key for each option must be entered to enable its functionality. Each option must also be configured as needed.

In addition to server software and options, the installation script performs the following tasks:

<table>
<thead>
<tr>
<th>Host names</th>
<th>Places the host name in the /usr/openv/netbackup/bp.conf file on the server. For clustered environments, the script places the virtual host name in the /usr/openv/netbackup/bp.conf file on the server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic startup and shutdown scripts</td>
<td>Adds automatic the startup and the shutdown scripts to the appropriate directories on the various supported platforms.</td>
</tr>
</tbody>
</table>
| PBX         | For the platforms that support PBX, NetBackup versions 7.x install or update PBX when the client software is installed. If the computer where you install NetBackup does not already have PBX and the platform supports it, the installation script installs PBX. If PBX already exists on the computer, the installation script performs one of the following tasks:  
  - Updates the existing version if it is older than the version that is included with 7.7.  
  - Does not update PBX if the existing version is the same or later than the version that is included with 7.7.  

Note: If you upgrade from NetBackup 6.0 or 6.5, PBX may not upgrade correctly. If the PBX upgrade is not successful, use the ICS disk from your 6.0 or 6.5 package to remove the older version. For complete details, see the Infrastructure Core Services Installation Guide for those NetBackup versions. |

About mounting the NetBackup software media

Use the examples in the following table as guidelines when you mount NetBackup DVDs. Check with your hardware vendor to see if you may need to use other flags or options.
Table 3-2  Flags and options for mounting NetBackup DVDs

<table>
<thead>
<tr>
<th>Flags or options</th>
<th>Defined</th>
</tr>
</thead>
<tbody>
<tr>
<td>-v, -t, -F</td>
<td>Specifies the type of file system to mount.</td>
</tr>
<tr>
<td>-o</td>
<td>Translates the file names properly if required.</td>
</tr>
<tr>
<td>-r</td>
<td>Specifies that you want to mount the DVD for reading.</td>
</tr>
<tr>
<td>device_path</td>
<td>Specifies the name of the DVD drive.</td>
</tr>
<tr>
<td>mount_point</td>
<td>Specifies the directory where you want to mount the DVD.</td>
</tr>
</tbody>
</table>

See “Mounting NetBackup software media on UNIX or Linux systems” on page 37.

Mounting NetBackup software media on UNIX or Linux systems

The following procedure describes how to mount the NetBackup DVD on UNIX or Linux systems.

To mount the NetBackup DVD on UNIX or Linux systems

1. Log in as root.
2. Create a mount point (all except Solaris).

    mkdir /dvd
3 (Conditional) on HP-UX systems earlier than 11.23, start PFS daemons.

```
nohup pfs_montd &
nohup pfsd &
```

4 Issue the appropriate mount command for your operating system.

- **AIX**
  ```
  mount -v cdrfs -r device_path
  mount_point
  ```

- **AIX**
  ```
  smitty cdrfs
  or
  smitty mountfs
  ```

- **FreeBSD**
  ```
  mount -r -t cd9660 device_path
  mount_point
  ```

- **HP-UX earlier than 11.23**
  ```
  pfs_mount -o xlat=unix device_path
  mount_point
  ```

  To find the device path, you can run `ioscan -fn`.

- **HP-UX later than 11.23**
  ```
  mount -F cdfs device_path
  mount_point
  ```

- **Linux**
  ```
  mount device_path mount_point
  ```

- **Solaris**
  ```
  mount -F cdfs device_path
  mount_point
  ```

If Volume Manager (`vold`) is running, the DVD mounts automatically.

If `vold` is not running, start it as follows:

```
/usr/sbin/vold &
```

---

**Installing NetBackup master server software on UNIX**

The master server manages backups, archives, and restores. The master server is where the NetBackup catalog resides which includes the internal databases that contain information about NetBackup configuration and backups.

Use the following guidelines for a new master server installation:

- **Designate master server**
  Designate the computer that you want to be the master server and install the master server software on that computer first.
Starting with NetBackup 7.6 you must configure EMM on the master server. All master servers must have their own EMM configuration. Remote EMM or shared EMM is no longer supported.

License keys

During master server installation, you must enter a NetBackup product license key. You must also enter license keys for any additional NetBackup product options or agents that are used on the server or its clients. These additional license keys must be entered on the master server.

If you add, delete, or make and save any license key updates in the NetBackup-Java Administration Console, you must restart the console.

For more information on how to administer NetBackup licenses, see the NetBackup Administrator’s Guide, Volume I.

http://www.symantec.com/docs/DOC5332

To install NetBackup master server software

1. Log in to the server as root.
2. Use one of the following methods to start the installation script:

   DVD
   - Insert the NetBackup Server DVD for the appropriate platform into the drive.
   - Check the DVD label to identify its contents.
   - See “About the NetBackup media kit” on page 18.
   - If necessary, mount the DVD.
   - See “About mounting the NetBackup software media” on page 36.
   - Enter the following command:
     
     `dvd_directory/install`
     
     The `dvd_directory` is the path to the directory where you can access the DVD.

   ESD images (downloaded files)
   - Navigate to the location where the installation images reside.
   - Enter the following command:
     
     `./install`
3 When the following message appears press Enter to continue:

Symantec Installation Script
Copyright 1993 - 2013 Symantec Corporation, All Rights Reserved.

Installing NetBackup Server Software

Please review the SYMANTEC SOFTWARE LICENSE AGREEMENT located on the installation media before proceeding. The agreement includes details on the NetBackup Product Improvement Program.

For NetBackup installation and upgrade information specific to your platform and to find out if your installed EEBs or hot fixes are contained in this release, check out the Symantec Operations Readiness Tools (SORT) Installation and Upgrade Checklist and Hot fix and EEB Release Auditor, respectively, at https://sort.symantec.com/netbackup.

ATTENTION! To help ensure a successful upgrade to NetBackup 7.7, please visit the NetBackup 7.x Upgrade Portal: http://www.symantec.com/docs/TECH74584.

Do you wish to continue? [y,n] (y)

4 For the NetBackup installation location and the option to upload the installation and the platform information to Symantec, enter the appropriate platform information as follows:

- When the following question appears, press Enter to accept the default (y) or type n and press Enter:

  Participate in the NetBackup Product Improvement Program? (y/n) [y]

- When the following question appears, press Enter to accept the default (y).

  The NetBackup and Media Manager software is built for use on <platform> hardware. Do you want to install NetBackup and Media Manager files? [y,n] (y)

- When the following question appears, select where to install NetBackup and Media Manager software:
NetBackup and Media Manager are normally installed in /usr/openv.
Is it OK to install in /usr/openv? [y,n] (y)

The path displayed for Solaris is /opt/openv.
To accept the default (y), press Enter.
To change the installation location, type n and press Enter. Then enter the appropriate destination.
Additional information about installation folder restrictions is available.
See "Restrictions on the NetBackup installation directory" on page 10.

5 Enter the NetBackup Server or Enterprise Server license key.

6 Type y, then follow the prompts to add license keys for other NetBackup options and agents.
Although you can add license keys later, you should enter them now. If you add any license keys later through the NetBackup-Java Administration Console, you must restart the console.

7 After all license keys are entered, type q to quit the License Key Utility and complete the server software installation.

8 Verify or enter the correct computer name when prompted by the following message:

Installing NetBackup Enterprise Server version: 7.7
If this machine will be using a different network interface than the default (name), the name of the preferred interface should be used as the configured server name. If this machine will be part of a cluster, the virtual name should be used as the configured server name.
The domainname of your server appears to be "domain". You may choose to use this domainname in your configured NetBackup server name, or simply use "name" as the configured NetBackup server name.
Would you like to use "name.domain" as the configured NetBackup server name of this machine? [y, n] (y)
Note: Incorrect information for the domain name results in failures during the configuration of Authentication Broker and NetBackup Access Controls. To correct this problem, use the `bpnbaz -configureauth` command to configure Authentication Broker. More information about the `bpnbaz -configureauth` command is available.

*Symantec NetBackup Commands Reference Guide*

http://www.symantec.com/docs/DOC5332

- To accept the displayed (default) name, press **Enter**.
- To change the displayed (default) name, type **n** and enter the name that you want.
- For a clustered NetBackup server, enter the virtual name for the NetBackup server and not the actual local host name.

9 Identify or verify the master server by answering the following question when it appears:

Is `<name>` the master server? [y, n] (y)

- To accept the displayed name (which is the name that you identified in the previous step), press **Enter**.
- If you entered a virtual name for the server in the previous step, the installation script presents the following question:

  Is this server part of a cluster installation?

  If the answer is yes, press **y** and answer the series of cluster configuration questions that appear.
  If the answer is no, press **n**.

10 Identify whether there are any media servers for this master server by answering the following question when it appears:

Do you want to add any media servers now? [y, n] (n)

- If there are no media servers for this master server, press **Enter** and proceed to the next step.
- If there are media servers for this master server, type **y** and enter the name of each media server.

  When you enter the media server names, you must enter the computer name and the domain name. For example:
Where `alpha` is the computer name and `min.symantec.com` is the domain name.
The media server names that you enter here are added to the `bp.conf` file on the master server, automatically. After you install the media server software later, the master server can then communicate with the media servers immediately.

- To add a media server to an existing and an operational NetBackup environment, you cannot use the procedures in this guide. For complete details on how to add a media server to an existing and an operational NetBackup environment, see the *NetBackup Administrator's Guide, Volume II*.

  http://www.symantec.com/docs/DOC5332

11 When the following message appears, press `Enter` and accept the default name of the EMM server. Starting with NetBackup 7.6 you must configure EMM on the master server. All master servers must have their own EMM configuration. Remote EMM or shared EMM is no longer supported.

NetBackup maintains a centralized catalog (separate from the image catalog) for data related to media and device configuration, device management, storage units, hosts and host aliases, media server status, NDMP credentials, and other information. This is managed by the Enterprise Media Manager server.

Enter the name of the Enterprise Media Manager (default: `<name>`)
Continuing with NetBackup software installation

After you have installed the master server software, you are ready to install media server software or client software depending on your environment.

- If you have media servers in your system, you are ready to install media server software.
  See “Installing NetBackup media server software on UNIX” on page 44.
- If there are no media servers in your environment, you are ready to install client software on client computers.
  See “Installing UNIX clients locally” on page 98.
- To install client software on clients from the master server location (recommended), you must first install the client type software on the master server.
  See “Installing client type software on a master server” on page 49.

Installing NetBackup media server software on UNIX

This section describes how to install a new NetBackup media server. Use this information to install the server software on a computer with no existing version of NetBackup.

Media server software manages the robotic and the storage devices within your NetBackup environment.

After you have installed the master server and the EMM server software, you are ready to install media server software on media server computers.

Use the following guidelines when you install new media servers:

<table>
<thead>
<tr>
<th>Designate media servers</th>
<th>Designate the computers that you want to be media servers and install the media server software on them.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clusters</td>
<td>New or initial NetBackup 7.x media servers cannot be installed as clusters. However, existing media servers with NetBackup 6.x that are clustered can be upgraded to NetBackup 7.x and still remain clustered.</td>
</tr>
<tr>
<td>EMM server</td>
<td>The EMM server must be installed and running before you install media server software.</td>
</tr>
</tbody>
</table>
License keys

When you install NetBackup media server software, you must enter a NetBackup product license key. You must also enter license keys for any additional NetBackup product options or agents that are used on the server or its clients. These additional license keys must be entered on each media server.

For more information on how to administer NetBackup licenses, see the NetBackup Administrator’s Guide, Volume I.

http://www.symantec.com/docs/DOC5332

Note: If you make and save any license key changes in the NetBackup-Java Administration Console, you must restart the console.

IBMzSeries RedHat and IBMzSeries SUSE

Starting with NetBackup 7.0.1, these platforms are supported for use as media servers only.

To install NetBackup media server software

1 Log in to the server as root.

2 Use one of the following methods to start the installation script:

- **DVD**
  - Insert the NetBackup Server DVD for the appropriate platform into the drive.
  - Check the DVD label to identify its contents.
  - See “About the NetBackup media kit” on page 18.
  - If necessary, mount the DVD.
  - See “About mounting the NetBackup software media” on page 36.
  - Enter the following command:
    
    ```
    dvd_directory/install
    ```
    
    The `dvd_directory` is the path to the directory where you can access the DVD.

- **ESD images (downloaded files)**
  - Navigate to the location where the installation images reside.
  - Enter the following command:
    
    ```
    ./install
    ```
3 When the following message appears, press Enter to continue:

Symantec Installation Script
Copyright 1993 - 2013 Symantec Corporation, All Rights Reserved.

Installing NetBackup Server Software

Please review the SYMANTEC SOFTWARE LICENSE AGREEMENT located on the installation media before proceeding. The agreement includes details on the NetBackup Product Improvement Program.

For NetBackup installation and upgrade information specific to your platform and to find out if your installed EEBs or hot fixes are contained in this release, check out the Symantec Operations Readiness Tools (SORT) Installation and Upgrade Checklist and Hot fix and EEB Release Auditor, respectively, at https://sort.symantec.com/netbackup.

ATTENTION! To help ensure a successful upgrade to NetBackup 7.7, please visit the NetBackup 7.x Upgrade Portal: http://www.symantec.com/docs/TECH74584.

Do you wish to continue? [y,n] (y)

4 For the NetBackup installation location and the option to upload the installation and the platform information to Symantec, enter the appropriate platform information as follows:

■ When the following question appears, press Enter to accept the default (y) or type n and press Enter:

  Participate in the NetBackup Product Improvement Program? (y/n) [y]

■ When the following question appears, press Enter to accept the default (y).

  The NetBackup and Media Manager software is built for use on <platform> hardware. Do you want to install NetBackup and Media Manager files? [y,n] (y)

■ When the following question appears, select where to install NetBackup and Media Manager software:
NetBackup and Media Manager are normally installed in /usr/openv.
Is it OK to install in /usr/openv? [y,n] (y)

The path displayed for Solaris is /opt/openv.
To accept the default (y), press Enter.
To change the installation location, type n and press Enter. Then enter the appropriate destination.

Additional information about installation folder restrictions is available.
See “Restrictions on the NetBackup installation directory” on page 10.

5 Enter the NetBackup Server or NetBackup Enterprise Server license key.

6 Type y, then follow the prompts to add license keys for other NetBackup options and agents.

Although you can add license keys later, you should enter them now. If you add any license keys later through the NetBackup-Java Administration Console, you must restart the console.

7 After all license keys are entered, type q to quit the License Key Utility and complete the server software installation.

8 Verify or enter the correct computer name when prompted by the following message:

Installing NetBackup Enterprise Server version: 7.7
If this machine will be using a different network interface than the default (name), the name of the preferred interface should be used as the configured server name. If this machine will be part of a cluster, the virtual name should be used as the configured server name.
The domainname of your server appears to be "domain". You may choose to use this domainname in your configured NetBackup server name, or simply use "name" as the configured NetBackup server name.
Would you like to use "name" as the configured NetBackup server name of this machine? [y, n] (y)
Note: Incorrect information for the domain name results in failures during the configuration of Authentication Broker and NetBackup Access Controls. To correct this problem, use the `bpnbaz -configureauth` command to configure Authentication Broker. More information about the `bpnbaz -configureauth` command is available.

Symantec NetBackup Commands Reference Guide

http://www.symantec.com/docs/DOC5332

- If the displayed (default) media server name is correct, press Enter.
- If the displayed (default) media server name is not correct, type n and enter the correct name.

9 Identify the master server that you have already installed, by answering the following question when it appears:

Is <name> the master server? [y,n]

- Type n and enter the fully qualified domain name of the master server.
- If the master server is clustered, enter the virtual name of the master server.

10 When the following message appears, press Enter and accept the default name of the EMM server. Starting with NetBackup 7.6 you must configure EMM on the master server. All master servers must have their own EMM configuration. Remote EMM or shared EMM is no longer supported.

Enter the name of the Enterprise Media Manager (default: <name>)

The master server name is displayed by default.

11 Repeat steps 1 through 10 to install media server software on any remaining media servers.

About pushing client software from a master server to clients

You can increase the speed of client installation by pushing the software from the master server to the clients. This method eliminates the need for a local installation at each client.

The following describes how to prepare your NetBackup environment for client software installation from the master server.
- Install the client type software on the master server. Be sure to install all of the client types that pertain to your NetBackup configuration. See “Installing client type software on a master server” on page 49.

- Before you can push client software from the master server, each client name must be assigned to a NetBackup policy. Policies are created on the master server. When you create a policy, you must identify the policy type, which indicates the operating system on the clients that are assigned to that policy. Without a policy, the remote installation (or push) fails because the master server does not know the operating system of the client.

  For information on how to create NetBackup policies, refer to the *NetBackup Administrator's Guide, Volume I*
  http://www.symantec.com/docs/DOC5332

- After the required policies are created, you can push client software from the master server to the clients.

  See “About remote installation methods for UNIX/Linux clients” on page 100.

### Installing client type software on a master server

Client type software must be installed on the master server to perform the following operations:

- Assign clients to NetBackup policies so that those clients can be backed up.

- Install (or push) client software from the master server to clients.

  For each UNIX client type, the client installation script lets you install the client software onto the master server. You can then install (or push) the client software from the master server to the clients.

**To install client type software on a master server**

1. Log in to the server as root.

2. Use one of the following methods to start the installation script:

   **DVD**
   - Insert the NetBackup UNIX Clients DVD into the drive.
     See “About the NetBackup media kit” on page 18.
   - If necessary, mount the DVD.
     See “About mounting the NetBackup software media” on page 36.
   - Enter the following command:
     
     ```
     dvd_directory/install
     ```
     The `dvd_directory` is the path to the directory where you can access the DVD.
ESD images (downloaded files)

- Navigate to the location where the installation images reside.
- Enter the following command:

  ./install

3  When the following message appears, press Enter to continue:

Symantec Installation Script
Copyright 1993 – 2013 Symantec Corporation, All Rights Reserved.

Installing NetBackup Client Software

Please review the SYMANTEC SOFTWARE LICENSE AGREEMENT located on the installation media before proceeding. The agreement includes details on the NetBackup Product Improvement Program.

For NetBackup installation and upgrade information specific to your platform and to find out if your installed EEBs or hot fixes are contained in this release, check out the Symantec Operations Readiness Tools (SORT) Installation and Upgrade Checklist and Hot fix and EEB Release Auditor, respectively, at https://sort.symantec.com/netbackup.

Do you wish to continue? [y,n] (y)

4  Select all of the client types that you want to install and follow the installation prompts.

Installing NetBackup add-on products

After your initial installation is complete, you can install any other NetBackup add-on products (such as language packages).

How to configure the window manager for the Java Interface (NetBackup-Java compatible platforms)

Always set your window manager so that windows become active only when you click inside the windows. Do not enable auto focus, where windows become active
if you move the mouse pointer over them. The NetBackup-Java interfaces do not run properly with auto focus enabled.
Installing server software on Windows systems

This chapter includes the following topics:

- Requirements for Windows NetBackup server installation
- About the NetBackup preinstallation Environment Checker
- Running the preinstallation Environment Checker
- Requirements for Windows cluster installations and upgrades
- Performing local, remote, or clustered server installation on Windows systems
- Post-installation tasks for NetBackup cluster environments
- Verifying Windows cluster installations or upgrades
- Installing NetBackup servers silently on Windows systems

Requirements for Windows NetBackup server installation

Before you install NetBackup, make sure that your backup environment meets the following requirements:

Other backup software Remove any other vendor’s backup software currently configured on your system. The backup software of another vendor can negatively affect how NetBackup installs and functions.
OS updates
Make sure that you have applied the most current operating system patches and updates. If you are not certain that your operating system is current, contact your operating system vendor and request the latest patches and upgrades.

Storage devices
Devices such as robots and standalone tape drives must be installed according to the manufacturers’ instructions and recognized by the Windows software.

Backup environment communication
Make sure that your network configuration allows all servers and clients to recognize and communicate with one another. Generally, if you can reach the clients from a server by using the ping command, the setup works with NetBackup.

Server configuration
The server system configuration should comply as follows:

- Operating system

- Memory
  Master servers in a production environment with several database agents enabled, should have a minimum of 8 GB of memory each.
  Media servers in a production environment with several database agents enabled, should have a minimum of 4 GB of memory each.
  For additional information about memory requirements, refer to the NetBackup Backup Planning and Performance Tuning Guide.
  http://www.symantec.com/docs/DOC5332

- Screen resolution
  Should be configured for at least 1024x768, 256 colors.

Disk space requirements
- An NTFS partition.
- NetBackup catalogs contain information about your backups, which become larger as you use the product. The catalog disk space requirements depend primarily on the aspects of your backup configuration. For example, the number of files that are backed up, the frequency of your backups, and how long you retain your backup data.
  For additional information about disk space requirements, refer to the NetBackup Getting Started Guide.
  http://www.symantec.com/docs/DOC5332
Make sure that you have all of the following items:

- NetBackup installation DVDs or ESD images
- Appropriate license keys
- Administrator account and password for all servers

**Note:** To install NetBackup on Windows 2008 Server, Windows 2008 R2 Server, Windows 2012 R2, and Windows 2012 UAC-enabled environments, you must log on as the official administrator. Users that are assigned to the Administrators Group and are not the official administrator cannot install NetBackup in UAC-enabled environments. To allow users in the Administrators Group to install NetBackup, disable UAC.

**Server names**

When you are prompted for server names, always enter the appropriate host names. Do not enter IP addresses.

**Mixed versions**

Make sure to install NetBackup servers with a release level that is at least equal to the latest client version that you plan to use. Earlier versions of server software can encounter problems with later versions of client software.

**CIFS-mounted file systems**

Symantec does not support installation of NetBackup in a CIFS-mounted directory. File locking in CIFS-mounted file systems can be unreliable.

**Installations on Windows 2008 Server Core**

You can only install NetBackup on these computers with the silent installation method.

See "Installing NetBackup servers silently on Windows systems" on page 73.

**NetBackup communication**

NetBackup services and port numbers must be the same across the network.

Symantec suggests that you use the default port settings for NetBackup services and Internet service ports. If you modify the port numbers, they must be the same for all master servers, media servers, and clients. The port entries are in the following file:

```
%SYSTEMROOT%\system32\drivers\etc\services
```

To change the default settings, you must perform a NetBackup custom installation of NetBackup or edit the `services` file manually.

**Remote Administration Console installation**

You must provide the names of Remote Administration Console hosts during master server installation.
Remote and cluster installations

In addition to all previously stated installation requirements, the following guidelines apply to remote installations and cluster installations:

- The source system (or primary node) must run Windows 2008 Server, Windows 2008 R2 Server, or Windows 2012/2012 R2.
- The destination PC (or clustered nodes) must have Windows 2008 Server, 2008 R2 Server, or Windows 2012/2012 R2.
- The Remote Registry service must be started on the remote system.

Starting with NetBackup 7.5.0.6, the NetBackup installer can enable and start the Remote Registry service on the remote system. If the Remote Registry service is not started, the installation receives the following error message:

Attempting to connect to server server_name failed with the following error: Unable to connect to the remote system. One possible cause for this is the absence of the Remote Registry service. Please ensure this service is started on the remote host and try again.

- The installation account must have administrator privileges on all the remote systems or on all nodes in the cluster.
- All nodes in a cluster must run the same operating system, service pack level, and version of NetBackup. You cannot mix versions of server operating systems.

About the NetBackup preinstallation Environment Checker

Note: The preinstallation Environment Checker is a deprecated utility. Symantec recommends use of the SORT tool.


https://sort.symantec.com/netbackup

Starting with NetBackup 7.1, an Environment Checker is included to help identify any problems that may prevent a successful NetBackup server installation or upgrade. The Environment Checker is currently only available for Windows.
The Environment Checker is available as a link on the DVD browser. The checker is a standalone function that you run before an installation or an upgrade.

The Environment Checker provides you with the following abilities:

- Assess a system to determine if it is ready for a new NetBackup installation or upgrade.
- Perform the assessment on local and remote Windows systems.
- Create a list of remote computers to check, either manually or by browsing the network.
- Run the Environment Checker on all supported Windows platforms that support NetBackup as a master server or a media server (x86 and x64).
- Generate HTML reports for immediate viewing.

See “Running the preinstallation Environment Checker” on page 56.

### Running the preinstallation Environment Checker

**Note:** The preinstallation Environment Checker is a deprecated utility. Symantec recommends use of the SORT tool.


[https://sort.symantec.com/netbackup](https://sort.symantec.com/netbackup)

Use the following procedure to run the Environment Checker and assess whether computers are ready for NetBackup installation.

**To run the Environment Checker**

1. Start the NetBackup Installation Wizard with one of the following methods:
   - **DVD media**
     Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled, navigate to the DVD drive and run `Browser.exe`.
   - **ESD images (downloaded files)**
     Navigate to the directory where the images reside and run `Browser.exe`.

2. On the **Home** screen, click **Preinstallation**.

3. On the **Preinstallation** screen, click **Run the preinstallation Environment Checker**.

4. On the **Welcome** screen, review the content and click **Next**.

5. On the **Choose** screen, select the systems to check as follows:
Local Environment Check (default)

To check the local computer only, leave this option checked and click Next.

After the computer check has completed, a summary page appears that describes the results.

Remote Environment Check

To check one or more remote computers, select this option and click Next.

Note: You can keep the Local Environment Check option to include the local computer. You can also deselect this option to exclude it.

On the Remote screen, add or remove computers to check as follows:

- **Add Server From List**
  Click this option to select a computer from a list of available systems on your network. Then click Next.
  Enter the appropriate User Name and Password for the selected computer, then click OK.

- **Add Server Manually**
  Click this option to add computer names manually.
  On the Manual Remote Computer Selection dialog box, enter the appropriate Domain Name and the Server Name, then click OK.
  On the Remote Computer Login Credentials dialog box, enter the appropriate User Name and Password, then click OK.

- **Remove**
  To remove a computer from the Remote Computers list, select the computer from the list and click Remove.

After all computers that you want to check are added to the Remote Computers list, click Next. The Environment Checker performs a validation process for each remote computer. After all have been completed, click Next to start the check on all listed computers.
When all computers have been checked, the Results screen displays a list of the checked systems with a brief result under each computer name. Click on a computer name to see the complete results for that computer. The following describes the symbols that may appear in a summary:

- Green check mark: Indicates that the item meets the requirements for a NetBackup installation or an upgrade.
- Yellow exclamation point: Indicates that a potential issue has been detected that may, or may not cause a problem for a NetBackup installation or an upgrade.
- Red X: Indicates that the item does not meet the NetBackup installation requirements. Any summary report items with a red X must be corrected before you attempt a NetBackup installation or an upgrade.

Note: Symantec recommends that you address all items that are marked with a yellow exclamation point and a red X. Then run the Environment Checker again.

To save the results file, do one of the following:

- To save the results file to the default location, leave the check mark for the Save Results To check box.
- To save the results file to a different location, click Change Path, enter the appropriate location, then click Save.

If you do not want to save the results file, click the Save Results To check box to remove the check mark.

To exit from the Environment Checker, click Finish.

See “About the NetBackup preinstallation Environment Checker” on page 55.

Requirements for Windows cluster installations and upgrades

In addition to the normal server requirements, NetBackup cluster installations require special considerations.

The following describes the guidelines for NetBackup cluster installations and upgrades on Windows systems:
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileges</td>
<td>To perform clustered installations, you must have administrator privileges on all of the remote nodes in the cluster. Symantec recommends that you keep a record of all nodes in the cluster and what software exists on each node.</td>
</tr>
<tr>
<td>NetBackup virtual name and IP address</td>
<td>Have the virtual name and IP address for NetBackup available. You must provide this information during installation.</td>
</tr>
<tr>
<td>Operating system on nodes</td>
<td>All clustered nodes must use the same operating system version, service pack level, and NetBackup version. You cannot run mixed server versions in a clustered environment.</td>
</tr>
<tr>
<td>Cluster support changes for media servers</td>
<td>Beginning with NetBackup 7.1, you cannot perform a new installation of a clustered media server. You can, however, upgrade existing 6.x clustered media servers to NetBackup 7.7 and still keep them clustered.</td>
</tr>
<tr>
<td>Windows Server Failover Clusters (WSFC)</td>
<td>• The shared disk that the NetBackup Group uses must already be configured in the cluster and online on the active node.</td>
</tr>
<tr>
<td></td>
<td>• Install NetBackup from the node with the shared disk (that is, the active node).</td>
</tr>
<tr>
<td></td>
<td>• Computer or host names cannot be longer than 15 characters.</td>
</tr>
<tr>
<td>VCS clusters</td>
<td>• For SFW-HA 4.1 and SFW-HA 4.2:</td>
</tr>
<tr>
<td></td>
<td>Make sure that you install the patch from the following website before you install versions 7.x or upgrade from versions 6.x:</td>
</tr>
<tr>
<td></td>
<td><a href="http://entsupport.symantec.com/docs/278307">http://entsupport.symantec.com/docs/278307</a></td>
</tr>
<tr>
<td></td>
<td>• All NetBackup disk resources must be configured in Veritas Enterprise Administrator (VEA) before you install NetBackup.</td>
</tr>
</tbody>
</table>
When you upgrade clusters, the `ltid` and the robotic daemons retrieve the device configuration for a particular cluster node from the EMM database. The cluster node name (provided by `gethostname`) stores or retrieves the device configuration in the EMM database. The cluster node name is used when any updates are made to the device configuration, including when `ltid` updates the drive status. The cluster node name is only used to indicate where a device is connected. The NetBackup virtual name is employed for other uses, such as the robot control host.

Performing local, remote, or clustered server installation on Windows systems

Use the following procedure to perform a local, a remote, or a clustered install of NetBackup on a Windows computer.

To install NetBackup 7.7 server software on a local, remote, or clustered Windows server

1. Log on to the system. Be sure to log on with administrator privileges.
   - For local installations, log on to the system where you want to install NetBackup.
   - For remote installations, log on to a system with network access to all of the hosts where you want to install NetBackup.
   - For cluster installations, log on to the active node (the node with the shared disk).

2. Start the NetBackup Installation Wizard with one of the following methods:
   - DVD media
     Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled, navigate to the DVD drive and run `Browser.exe`.
   - ESD images (downloaded files)
     Navigate to the directory where the images reside and run `Browser.exe`.

3. On the initial browser screen (Home), click Installation.


5. On the Welcome screen, review the content and click Next.

6. (Conditional) If you previously installed NetBackup 7.7 on this host, you see the Program Maintenance dialog.
Select **Modify** to change installation settings for the local host, or to use the local host as a platform to perform push installation to remote hosts.

Select **Repair** to restore NetBackup 7.7 to its original state on the local host.

Select **Remove** to remove NetBackup 7.7 from the local host.

7 On the **License Agreement** screen, do the following:

- **I agree to and accept the terms of the license agreement.**
  You must select this item to install the software.

- **Participate in the NetBackup Product Improvement Program.**
  By default, this option is enabled. To disable this option, click the check box to remove the check mark.

- Click **Next**.

8 On the **Symantec NetBackup Installation Type** screen, provide the following information:

**Where to install**

- For a local installation, select **Install to this computer only**.
- For a remote installation, select **Install to multiple computers on your network**.
- For a cluster installation, select **Install a clustered Master Server**.
  This option is available only if the installation process determines that your system is configured for a Windows Server Failover Cluster (WSFC) or VCS clustered environment.

**Typical**

Select this option to install NetBackup with the default settings.

**Custom**

Select this option to install NetBackup with the settings that you want.

Click **Next**.

9 On the **NetBackup License Key and Server Type** screen, provide the following information:
License Key

Enter the base product license key that you received with your product.

The license key that you provide determines which components you can select. For example, you can click the icon next to **NetBackup Master Server** only if you enter a master server license key.

For remote and cluster installations:

**Note:** The license key that you enter here gets pushed to the other nodes. Your license key may enable add-on products. If you push NetBackup to nodes that have an add-on product already installed, your key works for the add-on product(s).

During this installation process, the following occurs to verify that you have proper credentials to perform remote installations:

- When you select a clustered system for installation, NetBackup determines if you have proper administrator credentials on all nodes in the cluster.
  - If you do not have the proper credentials, the system is not added to the list.
- If you have the proper credentials, NetBackup performs a second check to determine if a license key is needed. If a key is needed and one was not entered, the system cannot be added to the list. You must enter a valid license key to install on that node.
  - If you enter an invalid license key, this screen remains visible until a valid key is entered.

**NetBackup Master Server**

Click this icon to install master server software.

**NetBackup Media Server**

For local or remote installations, click this icon to install media server software.

10 (Conditional) This step applies only to the local installations that are **Custom**. For **Typical** installations, skip to the next step.

This step describes how to select and configure the **NetBackup Installation Folder**, **NetBackup Port Numbers**, and the **NetBackup Services**.

- **NetBackup Installation Folder**
  - On this screen, you can select where the NetBackup files are installed.
By default, NetBackup files are installed to the following location:
C:\Program Files\VERITAS

To change the folder destination where NetBackup is installed:
- Click Change.
- Browse to the preferred location and designate a new or an existing folder.
- Click Next.

Additional information about installation folder restrictions is available.
See “Restrictions on the NetBackup installation directory” on page 10.

Click Next.

- **NetBackup Port Numbers**
  On this screen, you can change port numbers, if it is necessary in your configuration.
  You may need to change a port number if you encounter conflicts when NetBackup and another industry product try to share the same port. Another example is if a port conflict occurs with a firewall, which may cause security issues.
  To change a port number, select the port number that you want to replace and type the new number.
  Click Next.

- **NetBackup Services**
  On this screen, provide the following startup account and startup type information for NetBackup services:
Log On

Specify either Local System account or This account.

By default, the Local System account is selected, so that NetBackup uses the built-in system account. When this option is selected, the fields below it are disabled.

To specify a different account:

- Select This account.
- Enter the account information in the following fields:
  - Domain
  - Username
  - Password

Startup Type

This option determines whether NetBackup services start automatically if you need to restart the NetBackup host. The default is Automatic.

To start NetBackup services manually after a restart, select Manual.

Start job-related NetBackup services following installation

By default, job-related services are set to start automatically after the installation has completed.

To prevent job-related services from starting automatically, click on the box to clear the check mark.

Safe Abort Option

This option determines how the installation proceeds if a restart is required as part of the installation.

If you select this option and the installation process determines that a restart is required, the installation stops. The system is then rolled back to its original state.

If you do not select this option, the installation proceeds even if the installation process determines that a restart is required.

Click Next.
11 On the **NetBackup System Names** screen, provide the following information:

- **Master Server Name**
  (Conditional) For local master server installations, enter the name of the local computer. For a cluster installation, enter the cluster virtual server name.
  
  For media server installations, you must change the name to the master server name to which the media server is configured.

- **Additional Servers**
  Enter the names of any additional NetBackup master servers and media servers that you want to communicate with this server. Include the names of computers where you plan to install NetBackup later.
  
  To enter more than one name, separate each name with a comma or press **Enter** after each name.

- **Media Server Name**
  This field appears only for local NetBackup Enterprise media server installations.
  
  When you install media server software, this field defaults to the local server name.

- **OpsCenter Server Name**
  (Optional)
  OpsCenter is a web-based administration and management tool for NetBackup.
  
  If you have an OpsCenter server or plan to install one, enter the server name or the IP address for that server here.
  
  For a clustered server, do not use the virtual name. Instead, use the actual host name of the cluster node.

Click **Next**.

12 (Conditional) For remote installations only:

On the **Symantec NetBackup Remote Hosts** screen, specify the hosts where you want NetBackup installed.

- **Windows Destination Systems**
  Right-click **Windows Destination Computers** and select from the drop-down menu, or use the following methods:
Browse

Click here to search the network for the hosts where you want to install NetBackup.

- On the Available Systems dialog box, select the computer to add and click Next.
- On the Remote Computer Login Credentials dialog box, enter the User Name and the Password of the account to be used to perform the installation on the remote computers.
- If you plan to install to multiple remote computers, click the box next to Remember User Name and Password. Selecting this option prevents the need to enter this information for each remote computer.
- Click OK.
- On the Remote Destination Folder dialog box, verify or change the Destination Folder where NetBackup is installed. The default location is C:\Program Files\Veritas.
  If you plan to install to multiple remote computers and you want to use the same location, click the box next to Use this folder for subsequent systems. Selecting this option prevents the need to enter the location for each remote computer.

Import

Click here to import a text file that contains a list of host names. When you create the text file, the host names must be defined in the following format:

Domain\ComputerName
Add

Click here to add a host manually.

- On the Manual Remote Computer Selection dialog box appears, enter the Domain and the Computer Name, then click OK.
- On the Remote Computer Login Credentials dialog box, enter the User Name and the Password of the account to be used to perform the installation on the remote computers.
  If you plan to add and install to multiple remote computers, click the box next to Remember User Name and Password. Selecting this option prevents the need to enter this information for each remote computer.
- Click OK.
- On the Remote Destination Folder dialog box, verify or change the Destination Folder where NetBackup is installed.
  The default location is C:\Program Files\Veritas\.
  If you plan to install to multiple remote computers and you want to use the same location, click the box next to Use this folder for subsequent systems. Selecting this option prevents the need to enter the location for each remote computer.
- Click OK.

Remove

To remove a host from the Destination Systems list, select the host and click here.

Change

Click here to change the destination for NetBackup file installation on the selected remote host.

- Click Next.

13 (Conditional) For cluster installations only:

On the NetBackup Remote Hosts screen, specify the remote system information for installation on those computers.

- On the initial screen, right-click Browse.
- On the Available Systems dialog box, select the computer that you want to add. Control-click to select multiple computers.
  Click Next.
On the **Remote Computer Login Credentials** dialog box, enter the user name, password, and domain that NetBackup is to use on the remote system(s).

If you intend to add more remote computers, click the check box next to **Remember user name and password**.

When you provide credentials, you select cluster nodes and add them to the **Windows Destination Systems** list. These are the nodes on which you remotely install NetBackup. Make sure that you select your local host when you select systems to install.

Each time you choose a system, NetBackup performs system and license checks. For example, it verifies the system for a server installation that matches the type that you selected, as follows:

- **NetBackup not installed**
  - Considers the remote to be verified.

- **NetBackup already installed**
  - Compares the installation type on that system to the installation type that you request.

- **Invalid combination**
  - Notifies you of the problem and disallows the choice.
  - One example of an invalid combination is to try to install a Remote Administration Console on a remote system that is already a master server.

- **Remote system not a supported platform or level**
  - Notifies you of the problem and disallows the choice.

The installation procedure also verifies that you have proper administrator credentials on the remote system. If you do not have administrator credentials, the **Enter Network Password** screen appears, and prompts you to enter the administrator’s user name and password.

Click **OK** and continue selecting destination systems.

This process repeats for each node that you select. You can elect to retain the user name and password. In that case, you are prompted only when the user name or password is not valid.

Note the following about the push-install process in a clustered environment:

- You can install NetBackup on any number of nodes. However, the clustering service sets the limit for the number of nodes in a cluster, not NetBackup.

- Language packages and other NetBackup add-on products cannot be installed with the push method. Add-on products must be installed on each individual node in the cluster group. For instructions on how to install these products, refer to the NetBackup documentation that supports each product.
NetBackup pushes to the other nodes only the license key you enter at the beginning of the installation. Your license key may enable add-on products. If you push NetBackup to nodes that have an add-on product already installed, your key works for that product.

Click Next.

14 (Conditional) For cluster installations only:

On the Cluster Settings screen, you provide the virtual and the physical network information.

For new installations, the following configuration settings that you enter apply to all nodes:

- **Create a new Cluster Group**
  
  For new cluster installations, select this option.

- **IPv4 Clusters**
  
  The default cluster setting is IPv4.
  
  Enter the following addresses:
  
  - **Virtual IPv4 Address**
    
    The IP address to which the virtual server name should resolve.
    
    For new cluster installations, you must enter the address manually.
  
  - **IPv4 Subnet Mask**
    
    Identifies a subnetwork so that IP addresses can be shared on a local area network. This number correlates directly to the virtual IP address of the cluster.

- **IPv6 Clusters**
  
  To enable IPv6 clusters, select this option.
  
  Enter the following IP address:
  
  - **Virtual IPv6 Address**
    
    The IPv6 address must be entered in CIDR format.

- **NB Cluster Group Name**
  
  The name that is used to identify a NetBackup service group or resource group. The resources in any resource group are related and interdependent.

- **Virtual Host Name**
  
  The name by which NetBackup is known in the cluster.
  
  When you install the client software, this host name must be added to the Additional Servers field on the NetBackup System Names screen.
  
  The server uses this name when it communicates with the client nodes.
<table>
<thead>
<tr>
<th><strong>Path to Shared Data</strong></th>
<th>A directory on one of the shared disks in the cluster where NetBackup stores configuration information. If the letter for the disk (or drive) does not appear in the pull-down list, enter only the letter.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Public Network</strong></td>
<td>For NetBackup clustered environments, select a public network that is assigned to the node of the cluster. <strong>Warning:</strong> You must not select a private network that is assigned to this cluster.</td>
</tr>
</tbody>
</table>
| **Cluster Configuration** | After you set all of the parameters, click this icon to configure the cluster for use with NetBackup. The **Next** icon is not available until after successful cluster configuration. The text box provides the following information about the configuration:  
  - Identifies any existing clusters or NetBackup cluster groups.  
  - Indicates a successful configuration.  
  - Identifies any problems or errors that occurred during the configuration (configuration failure). **Note:** If you click **Cancel** after a successful cluster configuration for new installations, a pop-up message appears. The message asks if you are sure that you want to proceed with the cancelation. To cancel the installation and remove the new cluster group, click **Yes**. To continue with the installation and retain the new cluster group, click **No** and then click **Next**.  
  If the cluster configuration fails, see the NetBackup Clustered Master Server Administrator's Guide for information about how to resolve the problem.  
  [http://www.symantec.com/docs/DOC5332](http://www.symantec.com/docs/DOC5332) |

When the successful cluster configuration message appears, click **Next**.

15 On the **Ready to Install the Program** screen, review the **Installation Summary** that shows your selections from the previous steps.

**Note:** Symantec recommends that you review the summary screen for any warning messages. You can prevent installation and upgrade issues if you resolve any problems before you continue the installation.

Then select one of the following options:
Click **Install** to start the installation.

Click **Back** to view the previous screens and make any changes, then return to this screen and click **Install**.

Click **Cancel** to cancel the installation.

After you click **Install**, the installation process begins and a screen appears that shows you the installation progress. This process may take several minutes.

For remote and cluster installations, up to five installations occur simultaneously. When an installation is completed, another one begins so that a maximum of five installations are in progress.

16 On the **Installation Complete** screen, select from the following options:

**Add Keys** *(Conditional) For local installations only, Symantec recommends that you enter additional license keys now for any other NetBackup products you plan to install.*

- To enter additional license keys, click **Add Keys**.
- When the list of **Current License Keys** appears, click **Add Key** to enter a new license key, then click **Add**.
- After all license keys are entered, close the **Current License Keys** window.

**View installation log file** The installation log file provides detailed installation information and shows whether any errors occurred.

Examine the installation log at the following location:

```
%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\%
```

**Note:** When you perform a remote or a cluster installation to multiple computers, this option only lets you view the log for the local computer. Each computer that you selected for installation contains its own installation log file. To view the log file of a remote computer, open a Windows Explorer window and enter `\\<COMPUTERNAME>`. 

Search the installation log for the following error indications:

- Strings that include **Return Value 3**.
- Important log messages that are color coded as follows:
  - **Yellow** = warning.
  - **Red** = error.
Finish

Select one of the following to complete the installation:

- If you are done installing software on all servers, click the box next to **Launch NetBackup Administration Console now** and click **Finish**. The NetBackup Administration Console starts a Configuration Wizard so that you can configure your NetBackup environment.
- If you have more server software to install, click **Finish**. You can move on to the next computer and install the necessary server software.

17 Repeat the steps in this procedure for any other servers.
18 After all server software is installed, you are ready to install client software.

See “About NetBackup client installation” on page 83.
See “Post-installation tasks for NetBackup cluster environments” on page 72.
See “Verifying Windows cluster installations or upgrades” on page 73.

**Post-installation tasks for NetBackup cluster environments**

After NetBackup server software is installed in a cluster, note the possible actions you may need to take:

**Restart**

You may need to restart each of the cluster nodes after the installation is complete.

**WSFC and VCS clusters**

Under normal circumstances, cluster configuration is one of the final steps when you install NetBackup in a cluster. If this step is not done or does not complete successfully, you can use the **bpclusterutil** command from the active node to perform this step.

*For information on how to run bpclusterutil, see the NetBackup Commands Reference Guide.*

[http://www.symantec.com/docs/DOC5332](http://www.symantec.com/docs/DOC5332)

**WSFC clusters**

Any NetBackup resources that you took offline come back online automatically.

See “Verifying Windows cluster installations or upgrades” on page 73.
Verifying Windows cluster installations or upgrades

The Cluster Administration console lets you verify the installation or upgrade and view your current system structure.

To verify a successful WSFC cluster installation or upgrade through the Cluster Administration console

1. During a cluster installation, you can open the Cluster Administration console to see your current structure.

2. After you have completed the installation and the configuration process, the console shows the new cluster group configuration.

To verify a successful VCS cluster installation or upgrade through the Cluster Manager console

1. During a cluster installation, you can open the Cluster Administration console to see your current structure.

2. After you have completed the installation and the configuration process, the console shows the new cluster group configuration.

See “About NetBackup server configuration” on page 114.

Installing NetBackup servers silently on Windows systems

A silent installation avoids the need for interactive input in the same manner as performing a remote installation. Silent NetBackup installations are not supported if you want to run the NetBackup services as a specific user rather than the local system.

To perform a silent installation, you must first modify the appropriate NetBackup script. After script modification, you can run the script to initiate the silent installation.

Note: For Windows 2008 Server Core systems, you can only install NetBackup with this procedure.

To install NetBackup server software silently

1. Log on as administrator to the system where you want to install NetBackup.

2. Insert the NetBackup installation DVD or navigate to the location where the ESD images (downloaded files) reside.
3 Open Windows Explorer and copy the contents of the X86 or the X64 directory to a temporary directory on your hard drive. Choose the directory that is associated with the platform type that you want to install.

4 Since the source files are read-only, you must change the permissions for the copied files to allow the installation or the update.

5 In the temporary directory where the copied files reside, select the appropriate script to modify:
   - To install a master server, edit `silentmaster.cmd`
   - To install a media server, edit `silentmedia.cmd`
   - To install a NetBackup Remote Administration Console, edit `silentadmin.cmd`

6 Edit the following lines as needed for your installation:
   - `SET ADDITIONALSERVERS=media1,media2,media3`
     
     Enter the names of any additional NetBackup master servers and media servers that you want to communicate with this host. Include the names of servers where you plan to install NetBackup later. If no other servers are to communicate with this host, remove this line from the script.
   - `SET ABORT_REBOOT_INSTALL=0`
     
     This line lets you determine how you want the installation to continue if a restart is required. Select from the following settings:
By default, a silent installation does not abort if it is determined that a restart is required. If you leave this setting at 0, select one of the following tasks:

- After the installation is complete, check the installation log to see if a restart is required. If the string `in use` appears anywhere in the log, you must restart the system manually.
- Force an automatic restart after the installation is complete.
  To force an automatic restart, before you run the script, remove the following option from the silent installation command script (silent*.cmd):

  `REBOOT="ReallySuppress"

**Warning**: A forced restart occurs with no warning to the user. It does not cancel the installation or roll back the system to its original state.

0 (zero, default)
Select this setting to abort the installation if it is determined that a restart is required.

If a restart is needed, this setting cancels the installation and the system is rolled back to its original state.

1 (one)
Select this setting to abort the installation if it is determined that a restart is required.

If a restart is needed, this setting cancels the installation and the system is rolled back to its original state.

7  Save the script and run it.

8  Examine the installation log at the following location:

    `%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\`

    Search the installation log for the following error indications:

    - Strings that include `Return Value 3`
    - Important log messages are color coded as follows:
      Yellow = warning.
      Red = error.

After all server software is installed, you are ready to install client software.

See "About NetBackup client installation" on page 83.
About the NetBackup Remote Administration Console

The NetBackup Remote Administration Console is an interface-only version of NetBackup that you can use to administer NetBackup servers from another computer. The computer that runs the NetBackup Remote Administration Console does not require NetBackup software.

The following is a brief description of the NetBackup Remote Administration Console operation:

- The console lets you perform all NetBackup operations exactly like the NetBackup Administration Console on a local NetBackup server. You can create backup policies, manage volumes, view status, monitor tape drives, and perform other operations.

- The console displays the name of the server it administers, rather than a local host name.

- The console can only administer other NetBackup servers. It cannot act as a master or a media server.

Installing the NetBackup Remote Administration Console

Installation is a two-step process as follows:
Install the NetBackup Remote Administration Console.

Add the NetBackup Remote Administration Console host name to the server list of the hosts that you want to administer.

You must also add the host names of the servers that you want to administer to the server list on the host where you install the remote console.

The following table shows an example of the required server list entries for each host. RAC1 refers to the Remote Administration Console.

<table>
<thead>
<tr>
<th>Host name</th>
<th>Required server list entries</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master1</td>
<td>RAC1</td>
</tr>
<tr>
<td>Media1</td>
<td>RAC1</td>
</tr>
<tr>
<td>Media2</td>
<td>RAC1</td>
</tr>
<tr>
<td>RAC1</td>
<td>Master1, Media1, Media2</td>
</tr>
</tbody>
</table>

**Note:** You cannot install NetBackup Remote Administration Console on a computer where NetBackup server software is already installed.

**To install the NetBackup Remote Administration Console**

1. On the computer where you want to install the remote administration console, do one of the following:
   - Insert the appropriate DVD that contains the NetBackup software.
     - On Windows systems with Autorun enabled, the installation starts automatically.
     - On Windows systems with Autorun disabled, navigate to the DVD directory and run Browser.exe.
   - Navigate to the location where the downloaded files reside and run Browser.exe.

2. On the initial screen, select **Installation**.

3. On the **Installation** screen, click **NetBackup Administration Console Installation (x64 only)**.

4. On the **Welcome** screen, review the content and click **Next**.

5. On the **License Agreement** screen, accept the agreement and click **Next**.

6. On the **NetBackup Installation Type** screen, select **Install to this computer only** and **Typical Installation** and then click **Next**.
If an earlier version of the console already exists, you have the following options:

- Cancel the installation and remove the earlier version of the console. Then run the 7.7 console installation again.
- Specify an alternate installation location for the 7.7 version of the console.

7 On the **Ready to Install the Program** screen, review the Installation Summary and click **Install**.

8 On the **Installation Complete** screen, click **Finish**.

9 To open the console, click **Start > Programs > Symantec NetBackup > NetBackup Remote Admin Console**.

---

**Note:** Installing NetBackup Remote Administration console installs multiple versions of remote administration consoles. For example, when you install the remote administration console version 7.7, NetBackup Remote Administration Consoles for version 7.0 through 7.7 are all installed.

---

### Configuring server lists for the NetBackup Remote Administration Console

The following methods are available to configure server lists for the NetBackup Remote Administration Console:

- Use the NetBackup Administration Console
- On UNIX servers, edit the `bp.conf` file.
- On Windows servers, edit the system registry.

To configure server lists for the NetBackup Remote Administration Console by using the NetBackup Administration Console

1 On the **NetBackup Administration Console** in the left pane, click **Host Properties > Master Servers**.

2 In the **Master Servers** window in the right pane, right-click the name of the host server and select **Properties**.

3 In the **Master Server Properties** window, click the **Servers** icon from the tree in the left pane.

4 In the **Servers** window, click **Add**.

5 Enter the name of the host that is to run the NetBackup Remote Administration Console.
6   Click Add. The name of the host appears in the Additional Servers list.
7   Click Close and OK.

To configure server lists for the NetBackup Remote Administration Console by editing the bp.conf file on UNIX servers

1   Log in to the master server as root.
2   Edit the following file:

   /usr/openv/netbackup/bp.conf.
3   At the end of the SERVER = lines, add the following line:

   SERVER = Remote-Administration-Console-machine-name

   The Remote-Administration-Console-machine-name is the name of the computer where you installed the NetBackup Remote Administration Console.

To configure server lists for the NetBackup Remote Administration Console by editing the system registry on Windows servers

1   Log on to the master server as the administrator.
2   Click Start > Run....
3   Enter regedit.exe and click OK.
4   In the Registry Editor window, locate the following file:

   HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config
5   In the right pane, double-click on Server.
6   In the Edit Multi-String window, enter the name of the Remote Administration Console host and click OK.
7   Close the Registry Editor window.

Adding remote servers to administer from an existing NetBackup Remote Administration Console

If you have an existing NetBackup Remote Administration Console installed and you want to add a remote master server to administer, use this procedure.

To add a remote server to administer from an existing NetBackup Remote Administration Console

1   Log on to the host where the NetBackup Remote Administration Console is installed, and open the console.
2   In the left pane of the NetBackup Remote Administration Console, select Host Properties > Master Server.
3 In the Master Servers window in the right pane, right-click the name of the host server and select Properties (Read/Write).

4 In the Master Server Properties window, click the Servers tab.

5 In the Global Operations field, in the Add to all lists field, enter the host name. Make sure that you enter the name of the host that is to run the NetBackup Remote Administration Console.

6 Click the + icon (the name of the host appears in the Additional Servers list), then click OK.

About the NetBackup Administration Console

The NetBackup Administration Console can be used to administer one or more UNIX or Windows NetBackup servers. It provides all of the standard NetBackup server interfaces. The console can be used to create backup policies, manage volumes, view status, monitor tape drives, and other operations.

NetBackup Administration Console is installed when you install or upgrade NetBackup server packages.

See “Installing the NetBackup Java Administration Console” on page 80.

Installing the NetBackup Java Administration Console

You do not need to install NetBackup Administration Console separately. When you install or upgrade the master server, multiple versions of the NetBackup Java Administration Console are installed by default. For example, when you install or upgrade to NetBackup 7.7, versions 7.0 through 7.7 of the console are all installed.

Note: Symantec recommends that after you install or upgrade NetBackup server software, you should uninstall older versions of the Remote Administration Console (Windows and Java) present on the host. If the native NetBackup Administration Console for Windows is present, it is automatically uninstalled when you install or upgrade the NetBackup server software.

Installing or removing multiple versions of the NetBackup-Java Administration Console on Windows

A NetBackup environment may contain multiple servers with multiple NetBackup versions. You can install and remove multiple versions of the NetBackup-Java Administration Console.
Installing multiple versions of the NetBackup-Java Administration Console on Windows

To install multiple versions of the NetBackup interface in a mixed version environment, note the following restrictions and guidelines:

### Updates
Only the most recent version of the NetBackup-Java Administration Console can be updated (or patched).

### auth.conf file
The NetBackup-Java Capabilities Authorization configuration file (auth.conf), must always be located in `install_path/java`. For example, `C:\Program Files\Veritas\java`. The file must exist there regardless of how many versions of the console are installed, or in which directories they are installed.

The file is only used for administering NetBackup on this Windows host, and default settings exist if the file is not present. For more information about these defaults, see the section "Authorizing NetBackup-Java users" in the *NetBackup Administrator's Guide, Volume I*.

http://www.symantec.com/docs/DOC5332

### Console version location
You must install each Java console version to a different folder.

To install earlier versions of the NetBackup-Java Administration Console

1. Insert the appropriate version NetBackup Windows installation media with the NetBackup-Java Administration Console that you want to install.

2. Select one of the following consoles, based on the NetBackup version:
   - For NetBackup 6.0 versions, select **NetBackup Installation** and click **Install Java Administration Console**. Select whether you want to install the 32-bit or the 64-bit console.
   - For NetBackup 6.5 versions, select **NetBackup Installation** and click **Install Java Windows Administration Console**. Select whether you want to install the 32-bit or the 64-bit console.
   - For NetBackup 7.0 and 7.1 versions, select **Installation** and click **Java Windows Administration Console Installation**.
If a different version of the Java console has already been installed, specify a new folder location to prevent overwriting the earlier installation.

For example, specify `C:\Program Files\Veritas\nbjava65` for version 6.5 Java consoles.

To complete the installation, click **Finish**.

Removing earlier versions of the NetBackup-Java Administration Console on Windows

In some cases, you can remove earlier versions of the NetBackup-Java Administration Console by using the **Add/Remove Programs** feature. You can use this method if the version that you want to remove appears in the list of programs.

If the version that you want to remove does not appear in the list of programs, you must manually remove it. Use the following procedure.

To manually remove earlier versions of the NetBackup-Java Administration Console

1. Remove the folder where the earlier version NetBackup-Java Administration Console is installed.
2. Remove the appropriate menu item from the **Start > Programs > NetBackup** menu.
3. Remove any relevant desktop shortcuts.
Installing NetBackup client software

This chapter includes the following topics:

- About NetBackup client installation
- About NetBackup client installation on Windows
- About NetBackup client installation on UNIX/Linux

About NetBackup client installation

By definition, NetBackup servers are also clients. When you install NetBackup server software, client software is also installed.

When you install client software, you perform a true client installation since no server software is installed.

Client software can be installed locally at each individual computer or remotely. The operating system determines which clients can be installed remotely.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Installation Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>A Windows host can only push client software to Windows clients.</td>
</tr>
<tr>
<td></td>
<td>NetBackup does not need to be installed on the host that is used to perform the remote client installation.</td>
</tr>
<tr>
<td>UNIX or Linux</td>
<td>A NetBackup UNIX or Linux server can only push client software to UNIX or Linux clients.</td>
</tr>
<tr>
<td></td>
<td>NetBackup software and client type software must be installed on the server that is used to perform the remote client installation.</td>
</tr>
</tbody>
</table>
About NetBackup client installation on Windows

The NetBackup client installation wizard for Microsoft Windows lets you select the appropriate setup and installation options from a series of wizard screens. After you select options, a window appears that lets you verify your selections before the installation begins.

While the installation is in progress, a dialog box provides details of the installation and the setup progress. When the installation is completed, a final window shows the results.

Note the following when you install NetBackup client software on Windows systems:

Client installation restrictions  You cannot install NetBackup client software on the computers that currently have NetBackup server software. In these cases, you must first remove the NetBackup server software.

See “Removing NetBackup server software on Windows systems” on page 135.

See the NetBackup Installation Guide for Windows.

http://www.symantec.com/docs/DOC5332

User permissions

- By default on Windows 2008, 2008 R2, 2012, and 2012 R2 Server systems, only administrators have write permission to the Program Files directory.
- NetBackup writes log files and progress files to the following location:

  Program Files\VERITAS\NetBackup\Logs

  To perform backups and restores with the Backup, Archive, and Restore interface, users must have write permission to the Logs directory. Users without write permission to this directory receive an error message, and the backup or restore is canceled. The administrator account has write permission by default, but you must ensure that other users also have write permission.

About Windows client installation methods and requirements

You can install NetBackup clients on Windows systems with the following methods:
<table>
<thead>
<tr>
<th>Method</th>
<th>Requirements</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local installation</td>
<td>To install NetBackup client software locally, the system must meet the following configuration requirements:</td>
<td>The installation wizard installs the client software only on the computer where you run the installation. See “Installing NetBackup Windows clients locally or remotely” on page 87.</td>
</tr>
<tr>
<td></td>
<td>■ Any TCP/IP transport that is Windows Sockets compliant. (Use of the TCP/IP transport that comes with the server or the operating system is recommended.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ A network adapter that your TCP/IP transport supports</td>
<td></td>
</tr>
</tbody>
</table>
Table 6-1 Installation methods and requirements (continued)

<table>
<thead>
<tr>
<th>Method</th>
<th>Requirements</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote installation</td>
<td>To install NetBackup client software remotely, the system must meet the following configuration requirements:</td>
<td>The installation wizard scans the network for available clients where you can install the client software. The source computer must run Windows 2008, 2008 R2, 2012, or 2012 R2 Server. Also, a remote installation requires system administrator privileges. <strong>Note:</strong> You cannot install clients remotely from NetBackup Windows servers to UNIX computers. See “Installing NetBackup Windows clients locally or remotely” on page 87.</td>
</tr>
<tr>
<td></td>
<td>■ All the requirements for local installations must be met.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Administrator privileges are required for the user that performs remote installations.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Remote Registry service must be started on the remote system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the Remote Registry service is not started, the installation receives this error message:</td>
<td>Attempting to connect to server server_name failed with the following error: Unable to connect to the remote system. One possible cause for this is the absence of the Remote Registry service. Please ensure this service is started on the remote host and try again.</td>
</tr>
<tr>
<td>Silent installation</td>
<td>The requirements for silent installation are the same as the requirements for a local installation.</td>
<td>A silent installation is a process that does not require interactive input. However, you must edit the silentclient.cmd file before you run it. See “Installing NetBackup Windows clients silently” on page 93.</td>
</tr>
</tbody>
</table>

An NTFS disk partition is required for all installation types.

The NetBackup client version that you install must be the same or earlier than the installed version of NetBackup server software. Later client versions cannot be used with earlier server versions.

See “About compatibility between NetBackup versions” on page 11.
Installing NetBackup Windows clients locally or remotely

Use this procedure to install NetBackup on your local computer or on multiple computers on your network. You can stop the installation process at any time by clicking **Cancel** or by clicking **Back** to return to the previous window.

When you install Windows clients remotely, note the following:

- **Requirements**: Review the requirements for Windows client installation. See “About Windows client installation methods and requirements” on page 84.
- **Privileges**: You must have administrator privileges on the remote clients for the NetBackup installation to complete successfully.
- **Client name entries**: During installation, the client name is written to the registry in lowercase. For backups to work, the policies on the NetBackup server must specify the client names in lowercase.

**Note**: After client installation, you may need to restart the system for the changes to take effect. A message appears to alert you if a restart is necessary.

To install NetBackup client software locally or remotely on Windows systems

1. Log on as administrator on the host where you want to install the client software.
2. Start the NetBackup Installation Wizard with one of the following methods:
   - **DVD media**
     Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled, navigate to the DVD drive and run **Browser.exe**.
   - **ESD images (downloaded files)**
     Navigate to the directory where the images reside and run **Browser.exe**.
3. On the initial screen, select **Installation**.
4. On the **Installation** screen, select **Client Software Installation**.
5. On the **Welcome** screen, review the content and click **Next**.
6. (Conditional) If you previously installed NetBackup 7.7 on this host, you see the **Program Maintenance** dialog.
Select **Modify** to change installation settings for the local host, or to use the local host as a platform to perform push installation to remote hosts.

Select **Repair** to restore NetBackup 7.7 to its original state on the local host.

Select **Remove** to remove NetBackup 7.7 from the local host.

7 On the **License Agreement** screen, accept the terms of the agreement and click **Next**.

8 On the **Symantec NetBackup Client Installation Type** screen, provide the following information:

- **Where to install**
  - For a local installation, select **Install to this computer only**.
  - For remote installation, select **Install to multiple computers on your network**.
  - The procedure does not install the client on the local host unless you add it to the list of systems that you want to install.

- **Typical**
  - Select this option to install NetBackup with the default settings.

- **Custom**
  - Select this option to install NetBackup with the settings that you want.

Click **Next**.

9 (Conditional) This step applies only to local **Custom** installations.

On the **Symantec NetBackup Client Destination Folder** screen, you can select where the NetBackup files are installed.
Destination Folder

By default, NetBackup files are installed to the following location:
C:\Program Files\VERITAS

To change the folder destination where NetBackup is installed:

- Click Change.
- Browse to the preferred location and designate a new or an existing folder.
- Click Next.

Additional information about installation folder restrictions is available.

See “Restrictions on the NetBackup installation directory” on page 10.

Note: For upgrades, you cannot change the destination.

10 (Conditional) This step applies only to Custom installations.

On the NetBackup Options screen, select from the following options:

At System Startup

Enable or disable the following options:

- Start NetBackup Client Service Automatically
  By default, this option is enabled so that NetBackup services are available immediately after system startup.

- Start NetBackup Client Job Tracker Automatically
  By default, this option is disabled. To start this option manually after installation, click Start > All Programs > Symantec NetBackup > NetBackup Client Job Tracker.

Ports

On this screen, you can change port numbers, if it is necessary in your configuration.

You may need to change a port number if you encounter conflicts when NetBackup and another industry product try to share the same port. Another example is if a port conflict occurs with a firewall, which may cause security issues.

To change a port number, select the port number that you want to replace and type the new number.

Click Next.
11 On the **NetBackup Services** screen, provide the following startup account and startup type information for NetBackup client services:

**Log On**
Specify either **Local System account** or **This account**.

By default, the **Local System account** is selected, so that NetBackup uses the built-in system account. When this option is selected, the fields below it are disabled.

To specify a different system account:
- Select this option.
- Enter the account information in the following fields:
  - **Domain**
  - **Username**
  - **Password**

**Safe Abort Option**
This option determines how the installation proceeds if a restart is required as part of the installation or upgrade.

If you select this option and the installation process determines that a restart is required, the installation (or upgrade) stops. The system is then rolled back to its original state.

If you do not select this option, the installation (or upgrade) proceeds even if the installation process determines that a restart is required.

12 On the **NetBackup System Names** screen, the following fields are populated automatically. Changes are not normally required. Except for the **Client Name**, you can make changes as needed for your configuration.

**Client Name**
Do not change this name.

**Master Server Name**
If necessary, change this name to the appropriate master server where the client backup images are to be stored.

**Additional Servers**
Enter all of the master server and media server names that you want this client to access.

13 On the **Symantec NetBackup Remote Hosts** screen, specify the hosts where you want NetBackup installed.

**Destination Systems**
Right-click the **Windows Destination Computers** icon and select from the drop-down menu, or use the following icons:
Click here to search the network for the hosts where you want to install NetBackup.

- On the **Available Systems** dialog box, select the computer to add and click **Next**.
- On the **Remote Computer Login Credentials** dialog box, enter the **User Name** and the **Password** of the account to be used to perform the installation on the remote computers.
- If you plan to install to multiple remote computers, click the box next to **Remember User Name and Password**. Selecting this option prevents the need to enter this information for each remote computer.
- Click **OK**.
- On the **Remote Destination Folder** dialog box, verify or change the **Destination Folder** where NetBackup is installed. The default location is `C:\Program Files\Veritas`.
  If you plan to install to multiple remote computers and you want to use the same location, click the box next to **Use this folder for subsequent systems**. Selecting this option prevents the need to enter the location for each remote computer.

Click here to import a text file that contains a list of host names. When you create the text file, the host names must be defined in the following format:

```
Domain\ComputerName
```
Add

Click here to add a host manually.

- On the Manual Remote Computer Selection dialog box appears, enter the Domain and the Computer Name, then click OK.
- On the Remote Computer Login Credentials dialog box, enter the User Name and the Password of the account to be used to perform the installation on the remote computers. If you plan to add and install to multiple remote computers, click the box next to Remember User Name and Password. Selecting this option prevents the need to enter this information for each remote computer.
- Click OK.
- On the Remote Destination Folder dialog box, verify or change the Destination Folder where NetBackup is installed. The default location is C:\Program Files\Veritas. If you plan to install to multiple remote computers and you want to use the same location, click the box next to Use this folder for subsequent systems. Selecting this option prevents the need to enter the location for each remote computer.
- Click OK.

Remove

To remove a host from the Destination Systems list, select the host and click here.

Change

Click here to change the destination for NetBackup file installation on the selected remote host.

Click Next.

14 On the Ready to Install the Program screen, review the Installation Summary that shows your selections from the previous steps.

---

Note: Symantec recommends that you review the summary screen for any warning messages. You can prevent installation and upgrade issues if you resolve any problems before you continue the installation.

Then select one of the following options:

- Click Install to start the installation.
Click Back to view the previous screens and make any changes, then return to this screen and click Install.

Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears that shows you the installation progress. This process may take several minutes.

Up to five remote installations occur simultaneously. When a remote installation is completed, another one begins so that a maximum of five installations are in progress.

If you click Cancel after you click Install, the installation does not stop immediately. Installation continues on all remote hosts where the installation has already started. Any specified hosts after that point do not get client software installed.

NetBackup considers any remote installations that were completed when you clicked Cancel to be successful.

15 On the Installation Complete screen, click Finish.

Examine the installation log on the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\%

An installation log file provides detailed installation information and shows whether any errors occurred.

**Note:** When you perform a remote installation to multiple computers, this option only lets you view the log for the local computer. Each computer that you selected for installation contains its own installation log file. To view the log file of a remote computer, open a Windows Explorer window, enter \\<COMPUTERNAME>, and navigate to the InstallLogs directory.

Search the installation log for the following error indications:

- Strings that include Return Value 3.
- Starting with NetBackup 7.0, important log messages are color coded as follows:
  - Yellow = warning.
  - Red = error.

## Installing NetBackup Windows clients silently

A silent installation process does not require interactive input. It does, however, require that you edit the silentclient.cmd file before you run it.
Silent installations of NetBackup clients are not supported if you want to run the NetBackup services as a user instead of a local administrator.

To install NetBackup with a custom services account, refer to the following topics:

See "Installing NetBackup Windows clients locally or remotely" on page 87.

Use the following procedure to perform a silent installation of a local NetBackup client.

**To perform a silent installation of NetBackup client software on Windows**

1. Insert the NetBackup installation DVD in the drive or navigate to the location where the ESD images (downloaded files) reside.

2. In a **Microsoft Windows Explorer** window, navigate to the DVD drive.

3. Copy the contents of the one of the following directories to a temporary folder on your hard drive. For example, C:\temp.
   - PC_Cln\x86
   - PC_Cln\x64

4. Since the original source files are read-only, change the permissions for the copied files on the hard drive to allow the update.

5. In the temporary directory, use a text editor to edit the *silentclient.cmd* file so the script installs the client software as needed.

6. Run the *silentclient.cmd* script.

7. To verify that the installation was successful, check the installation log file in the following directory:

   %ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs

---

**How to configure NetBackup clients**

You can configure NetBackup clients by performing one of the following actions:

To add servers or media servers:

- Start the Backup, Archive, and Restore interface.
- Click **File > Specify NetBackup Machines**.

To display and change the client properties:

- Start the Backup, Archive, and Restore interface.
- Click **File > NetBackup Client Properties**.
To display and change the server properties:

- Open the NetBackup Administration Console.
- Expand Host Properties and click Clients.
- In the right pane, right-click on the client and choose Properties.
  In the dialog box that appears, on the Servers tab, all NetBackup servers that require access to your Windows client must be listed.

For complete information on client configuration, see the NetBackup Administrator's Guide, Volume I.

http://www.symantec.com/docs/DOC5332

About NetBackup client installation on UNIX/Linux

You can install UNIX/Linux clients either locally at the client computer or remotely from your UNIX/Linux NetBackup server. To install client software remotely from a UNIX/Linux NetBackup server, the client type software must first be installed on the UNIX/Linux server.

Note: Macintosh OS X clients are UNIX-based clients. Follow the installation procedures in this section.

Note the following when you install NetBackup client software on UNIX/Linux systems:
Starting with NetBackup 7.0, many of the add-on products and database agents are now installed with the NetBackup client package. Separate installation for these products is no longer needed.

The following products are now included in the NetBackup 7.7 client package (if the platform supports the product):

- BMR Boot server
- DB2
- Encryption
- Informix
- LiveUpdate agent
- Lotus Notes
- Oracle
- SAP
- Snapshot Client
- Sybase

The binaries for the listed products are laid down with the client package. A valid license is still required to enable the product. If product configuration was required previously (such as `db2_config`), configuration is still required.

The French, Japanese, and Chinese language packages remain as separate add-ons. The process to install and upgrade these products remains the same.

The `gzip` and `gunzip` commands must be installed on each system. The directories where the commands are installed must be part of the root user’s `PATH` environment variable setting.

To initiate a backup or a restore from a UNIX/Linux client, the following graphical interfaces are available:

- Clients that are compatible with NetBackup-Java may use the NetBackup-Java interface (`jbpSA`). Refer to the NetBackup Release Notes for a list of NetBackup-Java capable hosts.
- Clients that are not compatible with NetBackup-Java can use the `bp` interface. They also support a login from any NetBackup 7.7 UNIX server’s NetBackup client console with the `jbpSA` command.

Clients that are not compatible with NetBackup-Java are Macintosh OS X, IBM pSeries Linux, and FreeBSD.
About UNIX/Linux client installation methods

You can install NetBackup clients on UNIX/Linux systems with the following methods:

Local installations

- This method installs the client software on the computer where you run the installation script.
- To install clients to a location other than the default, you must create and link a directory before you install the client software. First, create the directory where you want the software to reside, then create /usr/openv as a link to that directory.
- On IBM zSeries Linux clients, you must transfer the NetBackup DVD or ESD image contents to a location that is readable by the virtual Linux environment. You can transfer the image with FTP or NFS mounting commands.

See “Installing UNIX clients locally” on page 98.
Remote (push) installations

- You can "push" the client software from your UNIX/Linux NetBackup server to your UNIX/Linux client computers. The UNIX/Linux client must be a true client and not a media server or a master server. The preferred installation method is to push the client software.

- Before you can push to a UNIX/Linux client, you must first install the NetBackup client type software on the server. Then, you must create a policy that includes the client name.
  
  [http://www.symantec.com/docs/D0C5332](http://www.symantec.com/docs/D0C5332)
  
  See "Installing client type software on a master server" on page 49.

- You cannot install Windows client software remotely from a NetBackup UNIX/Linux server.

- Firewalls can prevent remote client installation.

- Clients such as the IBM zSeries Linux may not have a locally mounted DVD device or access to the NetBackup DVD or ESD images. In these cases, you must push the client software from a UNIX/Linux master server or a media server.

- The following remote installation methods are available:
  
  See "Installing client software with the ftp method" on page 102.
  
  See "Installing client software with the rsh method" on page 101.
  
  See "Installing client software with the ssh method" on page 104.
  
  See "Installing client software with the sftp method" on page 105.

See “About NetBackup client installation” on page 83.

Installing UNIX clients locally

The following procedure installs the NetBackup client software on a local computer.

To install client software locally on a UNIX client

1. Use one of the following methods to start the installation script:
Insert the NetBackup UNIX Clients DVD into the drive.
See "About the NetBackup media kit" on page 18.

If necessary, mount the DVD.
See "About mounting the NetBackup software media" on page 36.

Enter the following command:

```
dvd_directory/install
```

The `dvd_directory` is the path to the directory where you can access the DVD.
Navigateto the location where the installation images reside.

Enter the following command:

```
./install
```

2. When the following message appears, press Enter to continue:

```
Symantec Installation Script
Copyright 1993 - 2013 Symantec Corporation, All Rights Reserved.

Installing NetBackup Client Software

Please review the SYMANTEC SOFTWARE LICENSE AGREEMENT located on the installation media before proceeding. The agreement includes details on the NetBackup Product Improvement Program.

For NetBackup installation and upgrade information specific to your platform and to find out if your installed EEBs or hot fixes are contained in this release, check out the Symantec Operations Readiness Tools (SORT) Installation and Upgrade Checklist and Hot fix and EEB Release Auditor, respectively, at https://sort.symantec.com/netbackup.

Do you wish to continue? [y,n] (y)

The client binaries represent the operating system versions where the binaries were compiled. The binaries typically function perfectly on later versions of the operating system. The installation procedure attempts to load the appropriate binaries for your system. If the script does not recognize the local operating system, it presents choices.

3. Follow the prompts to complete the installation.

Additional information about installation folder restrictions is available.

See “Restrictions on the NetBackup installation directory” on page 10.

4. After the installation is complete, select Exit from this Script.

About remote installation methods for UNIX/Linux clients

You can push the client software from a UNIX/Linux master server to a client host by using the following methods:
Installing client software with the rsh method

Before you perform this procedure, read the following guidelines:

Client /.rhosts file
To use this method, the UNIX client must have an entry for the server in its /.rhosts file. The /.rhosts entries enable software installation, but they are not necessary for correct operation of NetBackup software.

Client software location
If you want to install client software to a location other than the default, you must first create and link to the desired directory. Create the directory where you want the client software to reside, and then create /usr/openv as a link to that directory.

Additional information about installation folder restrictions is available. See “Restrictions on the NetBackup installation directory” on page 10.

Backup policies
Make sure that the clients are assigned to a backup policy.

For Macintosh OS X
By default, this operating system version does not enable the Remote Shell daemon (rshd). Run the following command to enable the daemon:

```
launchctl load -w /System/Library/LaunchDaemons/shell.plist
```
To install client software from a UNIX master server to UNIX clients with the `rsh` method

1. Start the **NetBackup Administration Console**.
2. On the **Login** dialog box, provide the name of the NetBackup server that contains the policy configuration with the clients.

   You can install the client software only from the NetBackup server that you specify in the **Login** dialog box when you start the interface. The clients must be defined in a policy on this NetBackup server.

3. In the main **NetBackup Administration Console** window, do the following:
   - In the left pane where the master server properties appear, click the icon next to **NetBackup Management**. The tree expands to show the available options.
   - In the center **All Policies** pane, select the master server.

4. Click **Actions** > **Install UNIX Client Software**. This action opens the **Install UNIX Client Software** window.

5. Select the client names to install from the **Don't install these clients** list and click **Add >**.

   The clients are moved to the **Install these clients** list.

6. To start the installation, click **Install Client Software**.

   You cannot stop the installation after it has started.

   Client software installation can take a minute or more per client. NetBackup writes messages in the **Progress** field as the installation proceeds.

   During installation, NetBackup copies client software from `/usr/openv/netbackup/client` on the server to `/usr/openv` on the client.

   If the installation fails on a client, NetBackup notifies you but keeps the client in the policy.

7. After the installation is complete, click **Close**.

**Installing client software with the `ftp` method**

Before you perform this procedure, read the following guidelines:

**Access to clients**

You must have a login ID and password that you can use to access the clients through FTP.
If you want to install client software to a location other than the default, you must first create and link the desired directory. Create the directory where you want the software to reside, and then create /usr/openv as a link to that directory.

Additional information about installation folder restrictions is available.

See “Restrictions on the NetBackup installation directory” on page 10.

Make sure that the clients are assigned to a backup policy.

By default, this operating system version does not enable the FTP daemon (ftpd), which is required. To enable the daemon, run the following command:

```
launchctl load -w /System/Library/LaunchDaemons/ftp.plist
```

To install client software from a UNIX master server to UNIX clients with the ftp method

1. To move the client software from the server to the /tmp directory on the client, run the `install_client_files` script on the NetBackup server.

   Use one of the following commands:

   - To move software to one client at a time, enter the following command:
     /usr/openv/netbackup/bin/install_client_files ftp client user
     The `client` is the host name of the client.
     The `user` is the login ID that FTP requires on the client.

   - To move software to all clients at once:
     /usr/openv/netbackup/bin/install_client_files ftp ALL user
     The `ALL` option specifies that you want to install all clients that are configured in any backup policy on the server.
     The `user` is the login ID required by FTP on the client.
     If you have not set up a `.netrc` file, the `install_client_files` script prompts you for a password for each client.

2. After the script runs, the root user on each client computer must run the following script:

   ```
   sh /tmp/bp.<pid>/client_config
   ```

   The `pid` is the process ID. The `client_config` script installs the binaries.
Installing client software with the ssh method

This client installation method is based on the usage of the SunSSH and the OpenSSH products, which must be at specific version and patch levels. For more information about these patches, please refer to the Symantec NetBackup 7.7 Release Notes.

Before you perform this procedure, read the following guidelines:

**SSH daemon (sshd)**
To use the ssh method, the UNIX client must have sshd enabled and configured to allow root user logins.

**Client software location**
If you want to install client software to a location other than the default, you must first create and link the desired directory. Create the directory where you want the client software to reside, and then create /usr/openv as a link to that directory.

Additional information about installation folder restrictions is available.

See “Restrictions on the NetBackup installation directory” on page 10.

**Backup policies**
Make sure that the clients are assigned to a backup policy.

**Macintosh OS X**
By default, this operating system version does not enable sshd. You must first enable this daemon to perform the following procedure successfully.

- In the System Preferences pane, select Sharing.
- Select Remote Login to enable sshd.

To install client software from a UNIX master server to UNIX clients with the ssh method

- On the NetBackup server, run the `install_client_files` script.

Use one of the following commands:

- To move software to only one client at a time:
  `/usr/openv/netbackup/bin/install_client_files ssh client`
  The `client` is the host name of the client.

- To move software to all clients at once:
  `/usr/openv/netbackup/bin/install_client_files ssh ALL`
  The `ALL` option specifies that you want to install all clients that are configured in any backup policy on the server.
Installing client software with the sftp method

This client installation method is based on the usage of the SunSSH and the OpenSSH products, which must be at specific version and patch levels. For more information about these patches, please refer to the Symantec NetBackup 7.7 Release Notes.

Before you perform this procedure, read the following guidelines:

**SSH daemon (sshd)**

To use this method, the UNIX client must have sshd enabled and configured to allow root or non-root user logins.

**Client file location**

If you want to install client software to a location other than the default, you must first create and link the desired directory. Create the directory where you want the software to reside, and then create /usr/openv as a link to that directory.

Additional information about installation folder restrictions is available.

See “Restrictions on the NetBackup installation directory” on page 10.

**Backup policies**

Make sure that the clients are assigned to a backup policy.

**Macintosh OS X**

By default, these operating system versions do not enable ssh. You must first enable this daemon to perform the following procedure successfully.

- In the System Preferences pane, select Sharing.
- Select Remote Login to enable sshd.

To install client software from a UNIX master server to UNIX clients with the sftp method

1. To move the client software from the server to the /tmp directory on the client, run the install_client_files script on the NetBackup server.

Use one of the following commands:

- To move software to one client at a time:
  
  /usr/openv/netbackup/bin/install_client_files sftp client user

  The client is the host name of the client.

  The user is the login ID that SSH requires on the client.

- To move software to all clients at once:
  
  /usr/openv/netbackup/bin/install_client_files sftp ALL user

  The ALL option specifies that you want to install all clients that are configured in any backup policy on the server.
The *user* is the login ID required by FTP on the client.

2. After the script runs, the root user on each client computer must run the following script:

```bash
sh /tmp/bp.<pid>/client_config
```

The *pid* is the process ID. The *client_config* script installs the binaries.

### Adding a UNIX/Linux client after initial server installation

You may want to add UNIX/Linux clients after the server installation if you forgot to select one during the installation. You may also add a new UNIX/Linux client type to your backup environment.

To install client software later, you must first install the NetBackup client software onto the NetBackup server.

#### To add UNIX/Linux client types to servers after initial installation

1. Use one of the following methods to start the installation script:

   **DVD**
   - Insert the NetBackup UNIX Clients DVD into the drive.
     See “About the NetBackup media kit” on page 18.
   - If necessary, mount the DVD.
     See “About mounting the NetBackup software media” on page 36.
   - Enter the following command:
     ```bash
dvd_directory/install
     ```

     The *dvd_directory* is the path to the directory where you can access the DVD.
ESD images (downloaded files)

- Navigate to the location where the installation images reside.
- Enter the following command:

  ./install

2 When the following message appears, press Enter to continue:

Symantec Installation Script
Copyright 1993 – 2013 Symantec Corporation, All Rights Reserved.

Installing NetBackup Client Software

Please review the SYMANTEC SOFTWARE LICENSE AGREEMENT located on the installation media before proceeding. The agreement includes details on the NetBackup Product Improvement Program.

For NetBackup installation and upgrade information specific to your platform and to find out if your installed EEBs or hot fixes are contained in this release, check out the Symantec Operations Readiness Tools (SORT) Installation and Upgrade Checklist and Hot fix and EEB Release Auditor, respectively, at https://sort.symantec.com/netbackup.

Do you wish to continue? [y,n] (y)

The client binaries represent the operating system versions where the binaries were compiled. The binaries typically function perfectly on later versions of the operating system. The installation procedure attempts to load the appropriate binaries for your system. If the script does not recognize the local operating system, it presents choices.

3 Select the client type that you want to load and follow the prompts to install that client type. Repeat as necessary until all of the client types you want are loaded.

Make sure that you load the software for all of the UNIX/Linux client types that you intend to install remotely from the server.

4 After the installation is complete, unmount the DVD.

5 Install the NetBackup client software on the clients you specified.

See “About remote installation methods for UNIX/Linux clients” on page 100.
Upgrading clients after servers are upgraded

The `update_clients` installation script lets you push client software to clients. It does not let you push client software to a remote client that is also a NetBackup media or master server. You cannot push software this way because the server software and client binaries must be of the same version on a single host.

The `update_clients` installation script can determine the full client list that is configured on the server. When it is run without any parameters, it attempts to update all clients (as determined by `/usr/openv/netbackup/bin/admincmd/bpplclients`). If you do not want to upgrade all clients, you can specify a subset of clients. Use the hardware type and operating system parameters or use the `-ClientList` parameter.

You can run `update_clients` from a media server. The `-ClientList` parameter is required in this situation. The script lets you maintain a media server and a set of clients at an earlier release level than the master server. Doing so requires the informed use of the `update_clients -ClientList` command on a master server and a media server to avoid unwanted client upgrades.

For clustered environments, you can push client software only from the active node.

During a client upgrade, the new client files are written to a directory in `/tmp` on the client. This directory must have sufficient space to temporarily store the new client files to ensure a successful upgrade. If sufficient space is not available, a status message informs you that the upgrade script could not write to the location in the `/tmp` directory. To resolve this issue, allocate more space to the `/tmp` directory and perform the upgrade procedure again. The temporary directory is removed when the upgrade is complete.

To upgrade clients after you have upgraded servers

1. Use one of the following methods to start the installation script:

   DVD
   - Insert the NetBackup UNIX Clients DVD into the drive.
   - See “About the NetBackup media kit” on page 18.
   - If necessary, mount the DVD.
   - See “Mounting NetBackup software media on UNIX or Linux systems” on page 37.
   - Enter the following command:

     ```
     cd_directory/install
     ```

     The `cd_directory` is the path to the directory where you can access the DVD.
ESD images (downloaded files)  
- Navigate to the location where the installation images reside.  
- Enter the following command:

```
./install
```

2 When the following message appears, press **Enter** to continue:

```
Installing NetBackup Client Software.  
Do you wish to continue? (y/n) [y]
```

The client binaries represent the operating system versions where the binaries were compiled. The binaries typically function perfectly on later versions of the operating system. For example, HP PA-RISC 11.11 binaries also are used on the HP PA-RISC 11.23 level of the operating system.

3 Select the client type that you want to load and follow the prompts to load that client type. Repeat as necessary until all desired client types have been loaded.

Make sure that you load the software for all of the UNIX client types that you intend to push to from this server. Otherwise, you cannot add these client types to the NetBackup policy configuration.

4 After the installation is complete, unmount the DVD.

5 As a root user on the NetBackup master server, enter the following command to see whether **bprd** is running:

```
/usr/openv/netbackup/bin/bpps
```

If **bprd** is running, stop it with the following command:

```
/usr/openv/netbackup/bin/admincmd/bprdreq -terminate
```

6 Enter the following command to make sure that backups or restores are not in progress:

```
/usr/openv/netbackup/bin/admincmd/bpdbjobs
```

7 Update UNIX client software by running the **update_clients** script. Specify the host names of the individual nodes (not virtual names) in the list of clients. Use one of the following commands:

- If you do not use a **-ClientList** file:
  
  ```
  /usr/openv/netbackup/bin/update_clients
  ```

- If you use a **-ClientList** file:
  
  ```
  /usr/openv/netbackup/bin/update_clients -ClientList filename
  ```
The -ClientList parameter is required on a media server.

For more than 30 clients, you can divide the list into multiple files and run update_clients for each file.

To create a client list file, perform the following steps:

- Change to the NetBackup admincmd directory, as follows:

```
cd /usr/openv/netbackup/bin/admincmd
```

- Use the `bpplclients` command to create a file that contains a list of clients currently configured in the NetBackup database. The options to use on this command differ depending on whether you push from a master server or from a media server, as follows:

```
If you push from the master server:
./bpplclients -allunique -noheader > file
```

```
If you push from a media server:
./bpplclients -allunique -noheader -M \m_server_name > file
```

The option descriptions are as follows:

- `m_server_name` Name of the NetBackup master server in this environment.
- `file` Name of the file to contain the list of unique clients. If no clients have been configured in the NetBackup database, the file is empty.

The `bpplclients` command writes output to `file` in the following format:

```
hardware os client
```

- `hardware` The hardware name. For example, run the `ls` command in directory `/usr/openv/netbackup/client`.
- `os` The operating system name. For example, run the `ls` command in directory `/usr/openv/netbackup/client/hardware`.
- `client` The name of the client.

The contents of `file` might look like the following example:

```
Solaris Solaris9 curry
```
1. (Optional) Edit file.
   Perform this step to change the contents of file. Edit file to contain only those clients you want to update with NetBackup client software. The host names of the clients must be the clients’ individual node names. They cannot be virtual names. The hostname command and the domainname command return the correct values for the individual node names. The format can be either hostname or hostname.domainname.

8. The update_clients script requests information from you. The following information appears in the script:

   Starting update_clients script.
   There are N clients to upgrade.
   Do you want the bp.conf file on the clients updated to list this server as the master server? (y/n) [y]

   Type either y or n.

   Enter the number of simultaneous updates you wish to take place. [1 - 30] (default: 15):

   Press Enter.

   The upgrade will likely take Y to Z minutes.
   Do you want to upgrade clients now? (y/n) [y]

   Type either y or n.

9. After all servers and clients are updated, start the bprd daemon as the root user on the master server by entering the following command:

   /usr/openv/netbackup/bin/initbprd
Configuring NetBackup

This chapter includes the following topics:

- About NetBackup startup and shutdown scripts
- About NetBackup server configuration

About NetBackup startup and shutdown scripts

When you install NetBackup, the installation script also performs configuration of startup and shutdown scripts. Startup scripts allow the NetBackup daemons to start automatically when the system boots. Shutdown scripts automatically terminate the startup scripts at system shutdown.

The installation process copies the NetBackup startup and shutdown scripts to the appropriate operating system location.

For non-cluster upgrades, any existing NetBackup related startup and shutdown scripts are saved, and the newly released versions of those scripts are installed.

Table 7-1 lists the links for the startup and the shutdown scripts for the various platforms that are installed during NetBackup installation.
### Table 7-1  
**NetBackup startup and shutdown script links by platform**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AIX</strong></td>
<td>/etc/rc.netbackup.aix</td>
</tr>
<tr>
<td></td>
<td>- The NetBackup installation script edited the <code>/etc/inittab</code> file and added the following entry to ensure that the script is called during a level-two boot:  netbackup:2:wait:/etc/rc.netbackup.aix</td>
</tr>
<tr>
<td></td>
<td>- To shut down, add the following line to the <code>/etc/rc.shutdown</code> file:  /etc/rc.netbackup.aix stop</td>
</tr>
<tr>
<td><strong>FreeBSD</strong></td>
<td>/usr/local/etc/rc.d/S77netbackup.sh -&gt; /usr/local/etc/netbackup</td>
</tr>
<tr>
<td><strong>HP-UX</strong></td>
<td>/sbin/rc1.d/K001netbackup -&gt; /sbin/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/sbin/rc2.d/S777netbackup -&gt; /sbin/init.d/netbackup</td>
</tr>
<tr>
<td><strong>Linux Debian</strong></td>
<td>/etc/rc0.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc1.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc2.d/S95netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc3.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc4.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc5.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc6.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td><strong>Linux Red Hat</strong></td>
<td>/etc/rc.d/rc0.d/K01netbackup -&gt; /etc/rc.d/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc.d/rc1.d/K01netbackup -&gt; /etc/rc.d/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc.d/rc2.d/S77netbackup -&gt; /etc/rc.d/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc.d/rc3.d/S77netbackup -&gt; /etc/rc.d/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc.d/rc5.d/S77netbackup -&gt; /etc/rc.d/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc.d/rc6.d/K01netbackup -&gt; /etc/rc.d/init.d/netbackup</td>
</tr>
</tbody>
</table>
Table 7-1  NetBackup startup and shutdown script links by platform (continued)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux SUSE</td>
<td>/etc/init.d/rc0.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rc2.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rc3.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rc5.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/init.d/rc6.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td>Macintosh OSX</td>
<td>/Library/StartupItems/netbackup/Resources/netbackup</td>
</tr>
<tr>
<td></td>
<td>/Library/StartupItems/netbackup/StartupParameters.plist</td>
</tr>
<tr>
<td></td>
<td>/Library/StartupItems/netbackup/netbackup</td>
</tr>
<tr>
<td>Solaris</td>
<td>/etc/rc0.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc1.d/K01netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
<tr>
<td></td>
<td>/etc/rc2.d/S77netbackup -&gt; /etc/init.d/netbackup</td>
</tr>
</tbody>
</table>

About NetBackup server configuration

After all server software is installed, you are ready to configure NetBackup to work with the robotic and the storage devices in your environment. Remember the operating system must recognize these devices as configured before you can configure them in NetBackup.

See “About storage device configuration” on page 20.

Use the following guidelines when you configure NetBackup:
NetBackup Enterprise servers  The procedures for configuring master and media servers are very similar. Symantec recommends, however, that you configure all server information such as storage devices and volumes from the master server. Following this order helps ensure that the master servers properly administer the media servers.

Warning: Communication problems between the master server and the media server do not prevent you from running the configuration wizards. Therefore, do not run the wizards on the media server until the problems are corrected. If you run any of the wizards when a communication problem exists, the master server cannot recognize the information that you enter. You must first correct the problem. After you correct the problem, run the configuration wizards from the master server.

Clustered environments  
- Configure devices on every node in the cluster.
- Start by configuring all storage devices from the active node so that they work with NetBackup.
- For a NetBackup failover server, attach all of the devices to each node in the cluster on which NetBackup is installed. Refer to the clustering vendor’s documentation for information on how to migrate to another node.
- Unless otherwise noted, configure NetBackup to use the virtual host names of master servers and media servers in the cluster.

For complete information on how to configure an add-on product to fail over, see the NetBackup Clustered Master Server Administrator’s Guide.
http://www.symantec.com/docs/DOC5332

For initial NetBackup server configuration, Symantec recommends that you launch the NetBackup Administration Console and click the Getting Started icon. A series of wizards guide you through the following configuration procedures:

- **Configure Storage Devices**  
  See “About the Device Configuration Wizard” on page 117.

- **Configure Volumes**  
  See “About the Volume Configuration Wizard” on page 119.

- **Configure the Catalog Backup**  
  See “About the Catalog Backup Wizard” on page 120.

- **Create a Backup Policy**  
  See “About the Backup Policy Configuration Wizard” on page 121.
If NetBackup is already configured and you want to change a specific area, click the appropriate wizard on the NetBackup Administration Console.

For complete information on all of the NetBackup wizards and how to configure NetBackup, see the *NetBackup Administrator's Guide, Volume I*.  

http://www.symantec.com/docs/DOC5332

See “About storage device configuration” on page 20.

**Starting the NetBackup Administration Console**

Use the following procedures to open the NetBackup Administration Console to configure NetBackup. The **Getting Started** wizard guides you through the primary configuration steps to make NetBackup function.

---

**Note:** Other wizards are available from the initial NetBackup Administration Console window that are not part of the **Getting Started** wizard. For example, you can configure disk pools or create a snapshot backup policy. See the *NetBackup Administrator's Guide, Volume I* for complete information about all NetBackup wizards.

http://www.symantec.com/docs/DOC5332

---

On Windowssystems, if you clicked the checkbox **Launch Administration Console** that appears at the end of NetBackup installation, you can skip this procedure.

**To start the NetBackup Administration Console on Windows**

1. Log on to the NetBackup server as the Administrator.

2. Click **Start > Programs > Symantec NetBackup > NetBackup Administration Console**.

3. To begin configuration, on the Administration Console, click **Getting Started**. The **Getting Started** screen appears and prompts you to begin device configuration.

---

**Note:** If you still need to configure devices to work with the operating system, close the wizard. You must first configure those devices as specified by the device and the operating system vendors.
To start the NetBackup Administration Console on UNIX

1 Log in to the NetBackup server as root.
   For clustered environments, log in to the active node as root.
   If you need to run the user interface on a computer other than the NetBackup server, log on to that computer. For UNIX systems, log in as root.

2 Enter the following command:
   
   `/usr/openv/netbackup/bin/jnbSA &`

3 Enter the password for root.
   For clustered environments, when you log in to the NetBackup Administration Console, specify the virtual host name in the Host field.

4 Click Login.

5 To begin configuration, on the Administration Console, click Getting Started.

6 On the initial Getting Started screen, review the content and click Next.
   The following screen prompts you to Configure Storage Devices.

   Note: If you still need to configure devices to work with the operating system, close the wizard. You must first configure those devices as specified by the device and the operating system vendors.

About the Device Configuration Wizard

Before you can run backups, you must define your storage devices for NetBackup. This wizard guides you through this process. You must, however, be certain that you have configured your storage devices correctly for your operating system. NetBackup cannot function reliably unless devices are installed and configured correctly.

See “About storage device configuration” on page 20.

For clustered environments, begin configuring all storage devices from the active node. For a NetBackup failover server, Symantec recommends that you attach all of the devices to every node on which NetBackup is installed.

For complete instructions, refer to the NetBackup Clustered Master Server Administrator's Guide.

http://www.symantec.com/docs/DOC5332

This wizard takes you through the following processes:
- Scans the hosts for backup devices
- Verifies the devices that were automatically detected
- Verifies and corrects the drive configuration
- Updates the device configuration

The wizard presents the following information when you configure devices:

Device configuration

- When the wizard displays the **Device Hosts** screen, you must specify the hosts on which to auto-discover and configure devices (NetBackup Enterprise servers only).
- When the wizard displays the **Backup Devices** screen, confirm that the list of devices is complete and accurate. If a known backup device does not appear in this list, take the following action:
  - Verify that the backup device is physically attached to the host.
  - Verify that all that specified device and operating system vendor installation procedures are performed successfully.
  - Verify that all drives correspond to the proper device. If you need to move a drive, select the drive and drag it to the correct location.
- For clusters, ensure that you perform storage device configuration on each node. Begin on the active node, then move the NetBackup active node to another node and perform the storage device configuration on that node. Repeat for each node of the cluster on which NetBackup runs.

**Note:** By default, robotic daemons and NetBackup add-on products do not cause NetBackup to failover if they fail. You can configure robotic devices and NetBackup add-on products to fail over NetBackup if the robot or the add-on product fails. The operating system must recognize the robots as configured before you can configure NetBackup to failover. For complete details about fail over configuration, refer to the *NetBackup Clustered Master Server Administrator’s Guide*.

http://www.symantec.com/docs/DOC5332
Defining storage units

- You define storage units from the **Configure Storage Units** screen. If your system does not have a tape device, you can store data on a disk by defining disk storage units.
- When you enter a path for a storage unit, the following rules apply:
  - Use the correct path separators (forward slash (/) for UNIX and backward slash (\) for Windows).
  - Use a colon (:) to specify a drive separation on Windows platforms.
  - Use the following characters only:
    - Alphabetic characters (ASCII A-Z, a-z)
    - Numeric characters (0-9)
    - Miscellaneous characters: plus (+), minus (-), underscore (_), or period (.)

See “About the Volume Configuration Wizard” on page 119.

### About the Volume Configuration Wizard

After you have configured your storage devices, the Getting Started Wizard starts the Volume Configuration Wizard. However, if you only have disk storage capability, NetBackup skips this wizard.

This wizard lets you initiate an inventory of each configured robot. NetBackup automatically updates the volume database if it finds new robotic media during the inventory. In addition, you can define new volumes for use in standalone drives.

For complete information about volumes or volume configuration for standalone drives, refer to the *NetBackup Administrator's Guide, Volume I*.

[http://www.symantec.com/docs/DOC5332](http://www.symantec.com/docs/DOC5332)

**Note:** For clustered environments, configure volumes from the active node.

This wizard lets you do the following tasks:

- Select a device for volume configuration
- Perform an inventory of the robot
- Create new volumes
- Create new volume groups

The wizard presents the following information when you configure volumes and perform inventory:
Robot or device inventory

- NetBackup conducts an inventory of the robot or the device that you selected. To view the results after the inventory has completed, see the **Results** field.
- After the device inventory has completed, the wizard prompts you to identify which device slots contain cleaning media.
  
  If you upgraded NetBackup and have pre-existing barcode rules, the barcode reader automatically detects the designated slots for the cleaning media. If you do not designate cleaning slots, NetBackup considers all media (including cleaning media) as typical media and tries to overwrite it.
- After the inventory has completed, you are prompted to identify which device slots contain cleaning media.
  
  If you identify one or more slots as cleaning media in the **Identify Cleaning Media** screen, you see the **Robot Inventory (Cleaning Media)** screen. This screen displays the results after the software updates the EMM database.
  
  If you do not designate cleaning media, NetBackup considers all media to be typical media (including cleaning media) and tries to overwrite it.

Standalone drives

- Specify the number of volumes for the device.
- The wizard does not let you configure cleaning tapes for standalone drives.

Multiple drive types

When you specify multiple drive types, the following are true:

- Media that is written by one robot drive may not work in any other drive. If this situation occurs, NetBackup considers the robot to have more than one type of drive.
- If the robot has more than one type of drive, the wizard cannot inventory the robot.

See “About the Catalog Backup Wizard” on page 120.

About the Catalog Backup Wizard

The NetBackup catalog contains information about your configuration and the locations of backed up files and directories. If a disk fails and your catalog is lost, a catalog backup makes it easy to restore your data and resume your backup schedule.

Therefore, you must configure a catalog backup policy before any data gets backed up.
This wizard lets you create a policy for an online, hot catalog backup. Online, hot catalog backups can back up the catalog while normal client backups are in progress.

A catalog backup policy lets you specify the following information:

- The destinations for the catalog backup
  A backup destination can be any configured storage device. For additional disaster recovery protection, you can specify a second location for your catalog backup.

  **Note:** Although NetBackup supports catalog backup to disk, Symantec recommends that you back up the catalog to a removable media that gets stored off-site.

- When the catalog backup occurs
- The location of the disaster recovery file that is needed to recover from the catalog backup

Use the following guidelines to configure a catalog backup:

- Configure a catalog backup policy before any other files or data are backed up.
- For clustered systems, configure the catalog backup policy from the active node.

For complete details about catalog backups, see the chapter “Protecting the NetBackup catalog” in the *NetBackup Administrator's Guide, Volume I.*

http://www.symantec.com/docs/DOC5332

For instructions on how to configure a catalog backup in clustered environments, see the *NetBackup Clustered Master Server Administrator's Guide.*

http://www.symantec.com/docs/DOC5332

### About the Backup Policy Configuration Wizard

This wizard lets you define a backup policy for a group of one or more clients. For clustered environments, configure the policy from the active node.

The wizard lets you specify the following:

- Policy names and types
- Clients
- Files and directories to back up
- Backup types
- Backup rotations
Starting times of backups

The wizard prompts you to choose the type of backup that you want a policy to perform.

Table 7-2 describes the available backup types.

<table>
<thead>
<tr>
<th>Backup type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full backup</td>
<td>Backs up all files that are specified in the file list.</td>
</tr>
<tr>
<td>Incremental backup</td>
<td>Backs up all the changed files that are specified in the file list.</td>
</tr>
<tr>
<td>Differential backup</td>
<td>Also referred to as a Differential incremental backup. Backs up the files that have changed since the last successful incremental or full backup. All files are backed up if no previous backup has been done.</td>
</tr>
<tr>
<td>Cumulative backup</td>
<td>Also referred to as a Cumulative incremental backup. Only the files that changed since the last full backup that was successful are backed up. All files are backed up if no previous backup has been done.</td>
</tr>
<tr>
<td>User backup</td>
<td>Initiated manually by a user to back up specific files.</td>
</tr>
</tbody>
</table>

Use the following guidelines when you create backup policies:

- The list that appears on the Client List screen of the Backup Policy Wizard is a list of clients that are backed up. You can add, change, or delete clients from the list.
- You can select how often you want a backup policy to run for full or incremental backups. In addition, you can select the retention period for the backups.

After you have completed the Backup Policy Wizard, you are asked if you want to perform an installation verification test. To do this test, click the Activity Monitor in the left pane of the NetBackup Administration Console. You can now monitor the progress of the backup job.
Upgrading NetBackup software

This chapter includes the following topics:

- About upgrading NetBackup
- About the NetBackup 7.x Upgrade Portal

About upgrading NetBackup

Starting with NetBackup 7.6, information about upgrades is no longer included in the Symantec NetBackup Installation Guide.

Complete upgrade information can be found in the Symantec NetBackup Upgrade Guide on the NetBackup Upgrade Portal. The portal can be accessed by clicking on the following link:

http://www.symantec.com/docs/TECH74584


See “About the NetBackup 7.x Upgrade Portal” on page 123.

About the NetBackup 7.x Upgrade Portal

The NetBackup 7.x Upgrade Portal contains the necessary information and instructions for upgrades to version 7.7. The following is a link to the portal:

http://www.symantec.com/docs/TECH74584

You must perform an upgrade to NetBackup 7.7 as described in the portal documentation.
To help you plan and prepare for an upgrade to NetBackup 7.7, the following describes the important information that can be found on the portal:

- **Catalog backup**
  Before the upgrade, a catalog backup should be created to provide a backup of the catalog in case of a failed upgrade.

- **NetBackup Catalog Check (NBCC) utility for NetBackup 7.7.**
  Before the upgrade, the catalog should be checked to make sure that it is free of any inconsistencies that may cause the upgrade to fail. If the NBCC results show any catalog inconsistencies, you must seek assistance from Symantec Enterprise Support for additional guidance.

- **Upgrade to NetBackup OpsCenter 7.7**
  The *Symantec NetBackup OpsCenter Administrator’s Guide* provides important notes for upgrading to NetBackup OpsCenter 7.7. This upgrade must be done before you upgrade to NetBackup 7.7.
  [http://www.symantec.com/docs/DOC5332](http://www.symantec.com/docs/DOC5332)

- **Catalog cleanup.**
  Your current NetBackup catalog must be free of any inconsistencies that may prevent a successful upgrade.

- **Upgrade to NetBackup 7.7**
  After the catalog cleanup and the NBCC results are declared as acceptable and you have upgraded to NetBackup OpsCenter 7.7, begin the NetBackup 7.7 upgrade.

If you have any questions or concerns about the upgrade process for NetBackup 7.7, please contact Symantec Enterprise Support.

Removing NetBackup server software

This chapter includes the following topics:

- About NetBackup server software removal on UNIX systems
- Removing NetBackup from UNIX servers
- About NetBackup server software removal on Windows systems
- Removing NetBackup server software on Windows systems
- Removing NetBackup server software in a clustered environment
- Removing NetBackup LiveUpdate from Windows systems
- About removal of the Java Console state data from Windows servers and Windows clients

About NetBackup server software removal on UNIX systems

NetBackup removal procedures remove NetBackup completely, along with any installed add-on products. Each procedure gives you the opportunity to save any data that you want and to remove add-on products before you remove NetBackup.

Symantec recommends that you use the following order when you remove NetBackup server software:

- Save any data that you require.
  This task is very important if you plan to reinstall NetBackup at a later date.
- Remove any add-on products before you remove NetBackup server software.
Remove the NetBackup server software.

See “Removing NetBackup from UNIX servers” on page 126.

See “About NetBackup software removal on UNIX/Linux clients” on page 140.

See “Removing NetBackup from UNIX/Linux clients” on page 140.

Removing NetBackup from UNIX servers

Use this procedure to remove NetBackup from a UNIX server. You may also need to reference other documents for procedures of specific tasks to remove NetBackup successfully.

Use the following guidelines when you remove NetBackup from UNIX servers:

- **NetBackup relational database (NBDB) location**
  - If you moved the NBDB files in `/usr/openv/db/data` from their default installation location, this procedure includes a step that describes how to remove these files.

- **Clustered environments**
  - Before you begin to remove NetBackup, you must remove NetBackup from the cluster application. Follow the instructions in your cluster documentation on how to remove a group, then you can remove NetBackup.
  - You must remove NetBackup from each node in the cluster.

- **HP-UX Service Guard Clusters**
  - If NetBackup has been configured to run as a clustered package, you must also delete the following directory:
    
    `/etc/cmcluster/netbackup`

- **PBX**
  - When you remove NetBackup, PBX is not removed. You must remove PBX manually. This procedure includes a step that describes how to perform this task.
  - **Warning:** Do not remove PBX if your server uses other Symantec software products that require PBX to run.

- **NetBackup Administration Console**
  - The NetBackup Administration Console must be closed when you remove NetBackup. Otherwise, NetBackup may cause a failure that forces you to restart the procedure.

To remove NetBackup from UNIX servers

1. Log on as the root user on the server.
2. Perform a catalog backup.
3. If the NetBackup Administration Console is open, you must close it now.
4 Save all important data from any add-on products that you have installed.

5 Stop the NetBackup/Media Manager daemons with the following command:

```
/usr/openv/netbackup/bin/bp.kill_all
```

6 Identify any installed add-on products by using the following command:

```
AIX lslpp -L
HP-UX swlist
Linux rpm -qa
Solaris pkginfo
```

Seven add-on products can be installed on the server. They are:

- SYMCfrnb
- SYMCfrnbc1t
- SYMCjanb
- SYMCjanbc1t
- SYMCzhnb
- SYMCzhnbclt
- SYMCnbsds

Remove any add-on products found.

7 For Solaris systems only, run the following command:

```
/usr/openv/volmgr/bin/driver/sg.install -deinstall
```

8 To unregister NetBackup from the VxUL master configuration that is stored in the `/etc/vx/vrtslog.conf` file, run the following command:

```
/usr/openv/netbackup/bin/vxlogcfg -r -p 51216
```

   The `-p` option specifies the product ID, which is 51216 for NetBackup.

9 If BMR is supported and enabled on the server, remove the associated files with the following command:

```
/usr/openv/netbackup/bin/bmrsetupmaster -undo -f
```

10 To unregister all NetBackup products with LiveUpdate, enter the following command:

```
/usr/openv/netbackup/bin/nblu_registration -r
```

11 If you moved the NBDB files from their default installation location, you must delete these files manually as follows:
- Navigate to the following directory where the NBDB files reside:
  /usr/openv/db/data

- Open the vxdbms.conf file.
  This file contains a list of the database-related files and the path for each file.

- Delete each of the database-related files.

12 If NetBackup Fibre Transport is supported and enabled on the server, remove the associated files with the following command:

   /usr/openv/netbackup/bin/admincmd/nbftsrv_config -d

13 For the clients that support PureDisk, remove all PureDisk files with the following command:

   /opt/pdag/bin/uninstall.sh

14 For the clients that support MSDP, remove all MSDP files with the following command:

   /opt/pdde/pddeuninstall.sh -basedir /usr/openv/pdde/ -ostdir 
   /usr/openv/lib/ost/plugins/ -forceclean

**Note:** Be aware the preceding command is a single command which takes three parameters (basedir, , ostdir, and forceclean), and two directory parameters take paths as input.

15 To remove the NetBackup server package, run the following command:

- AIX
  installp -u SYMCnetbp

- HP-UX
  swremove SYMCnetbp

- Linux
  rpm -e SYMCnetbp

- Solaris
  pkgrm SYMCnetbp

  - When the script asks if you want to remove the installed package SYMCnetbp, enter y and press Enter.

  - When the script asks if you want to continue with the package removal using superuser permission, enter y and press Enter.
16 Remove the NetBackup-Java Display Console by using the appropriate native command as follows:

AIX
installp -u SYMCnbjava

HP-UX
swremove SYMCnbjava

Linux
rpm -e SYMCnbjava

Solaris
pkgrm SYMCnbjava

17 Remove the NetBackup Java Runtime Environment by using the appropriate native command as follows:

AIX
installp -u SYMCnbjre

HP-UX
swremove SYMCnbjre

Linux
rpm -e SYMCnbjre

Solaris
pkgrm SYMCnbjre

18 Remove the NetBackup client by using the appropriate native command as follows:

AIX
installp -u SYMCnbclt

HP-UX
swremove SYMCnbclt

Linux
rpm -e SYMCnbclt

Solaris
pkgrm SYMCnbclt

19 Remove PBX with the appropriate native command as follows:

Note: Remember, you should not remove PBX if your server uses other Symantec software products that require PBX to run.

AIX
installp -u VRTSpbx

HP-UX
swremove VRTSpbx

Linux
rpm -e VRTSpbx

Solaris
pkgrm VRTSpbx
To remove the /usr/openv directory, select one of the following methods:

**Warning:** The `rm -f /usr/openv` command also removes any add-on products that are installed on the computer where you perform this command.

- If `/usr/openv` is the actual directory, run the following command:

  ```bash
  rm -rf /usr/openv
  ```

- If `/usr/openv` is a symbolic link to that directory, run the following commands:

  ```bash
cd /usr/openv
pwd
ls
  ```

**Warning:** Before you continue, make sure that you are at the correct location and verify that the subdirectories are what you expect them to be. To help prevent removing the wrong directories, the previous commands verify your current location and list the files in that directory. After you verify the directory location and its contents, remove the directory with the next commands.

  ```bash
  rm -rf *
cd /
rm -f /usr/openv
  ```

**Note:** Depending on your operating system, you may need to use the `rmdir` command to remove the `/usr/openv` directory.

```bash
rmdir /usr/openv
```

For Linux systems only:

If you modified the startup and the shutdown scripts, run the following command:

```bash
/sbin/chkconfig --del netbackup
```

See “About NetBackup startup and shutdown scripts” on page 112.
22 Remove the following startup scripts:

<table>
<thead>
<tr>
<th>On AIX systems:</th>
<th>/etc/rc.netbackup.aix</th>
</tr>
</thead>
</table>
| On HP-UX systems: | /sbin/init.d/netbackup  
|                  | /sbin/rc1.d/K001netbackup  
|                  | /sbin/rc2.d/S777netbackup |
| On Linux Debian systems: | /etc.init.d/netbackup  
|                           | /etc/rc0.d/K01netbackup  
|                           | /etc/rc1.d/K01netbackup  
|                           | /etc/rc2.d/S95netbackup |
| On Linux Red Hat systems: | /etc/rc.d/init.d/netbackup  
|                           | /etc/rc.d/rc0.d/K01netbackup  
|                           | /etc/rc.d/rc1.d/K01netbackup  
|                           | /etc/rc.d/rc2.d/S77netbackup  
|                           | /etc/rc.d/rc3.d/S77netbackup  
|                           | /etc/rc.d/rc5.d/S77netbackup  
|                           | /etc/rc.d/rc6.d/K01netbackup |

The following startup scripts appear only if NetBackup Fiber Transport was enabled on the server:

| /etc/rc.d/init.d/nbftserver  
| /etc/rc.d/rc0.d/K03nbftserver  
| /etc/rc.d/rc1.d/K03nbftserver  
| /etc/rc.d/rc2.d/S21nbftserver  
| /etc/rc.d/rc3.d/S21nbftserver  
| /etc/rc.d/rc5.d/S21nbftserver  
| /etc/rc.d/rc6.d/K03nbftserver |
On Linux SUSE systems:
/etc/init.d/netbackup
/etc/init.d/rc0.d/K01netbackup
/etc/init.d/rc2.d/S77netbackup
/etc/init.d/rc3.d/S77netbackup
/etc/init.d/rc5.d/S77netbackup
/etc/init.d/rc6.d/K01netbackup

The following startup scripts appear only if NetBackup Fiber Transport was enabled on the server:

/etc/init.d/nbftserver
/etc/init.d/rc2.d/K01nbftserver
/etc/init.d/rc2.d/S05nbftserver
/etc/init.d/rc3.d/K01nbftserver
/etc/init.d/rc3.d/S05nbftserver
/etc/init.d/rc5.d/K01nbftserver
/etc/init.d/rc5.d/S05nbftserver

On other servers:
/etc/init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S77netbackup

The following startup scripts appear only if NetBackup Fiber Transport was enabled on the server:

/etc/init.d/nbftserver
/etc/rc0.d/K03nbftserver
/etc/rc1.d/K03nbftserver
/etc/rc2.d/S21nbftserver

23 For AIX systems only:

- In the /etc/inittab file, remove the following NetBackup entry:

  /etc/rc.netbackup.aix

- In the /etc/rc.shutdown file, remove the following line:

  /etc/rc.netbackup.aix stop

24 Remove Symantec LiveUpdate components as follows:

- If NetBackup is the only Symantec product that currently uses LiveUpdate, run the following command:

  /opt/Symantec/LiveUpdate/uninstall.sh -a
If LiveUpdate is the only product installed in the /opt/Symantec directory, remove the following files:

```
rm -f /etc/Symantec.conf
rm -f /etc/Product.Catalog.JavaLiveUpdate
```

25 To remove the NetBackup-Java application state data for the root account, run the appropriate command as follows:

**Warning:** Do not insert a space between the slash character (/) and the period or the dot character (.) of /.veritas. A space between these characters removes all of your files from the root level and beyond.

- To remove the NetBackup-Java application state data for the root account for all releases, run the following command:
  
  `/bin/rm -rf /.veritas`

- To remove the NetBackup-Java application state data for the root account for a specific release, run the following command:

  `/bin/rm -rf /.veritas/java/<version>`

  Where `<version>` is the six-digit NetBackup version number. For example, NetBackup version 7.7 with no upgrades applied would be entered as `770000`.

26 Inform NetBackup-Java users that they can remove their `$HOME/.veritas` directory.

The `$HOME/.veritas` and the `$HOME/.veritas/java` directories contain application state information, that is saved when the user exits NetBackup-Java applications. The saved information includes table column order and size. The process removes this directory for the root user only.

The common subdirectory in `$HOME/.veritas/java/.userPrefs/vrts` can be removed.

27 If you enabled NetBackup Access Control, NetBackup placed several files on clients and servers. These files can be divided into the following categories:

- NetBackup application temporary files
  These files are removed with NetBackup.
These cache files reside in the $HOME/.vxss directory. Inform all users that they can remove this directory.

Files are generated in the /.vxss directory by a Single Sign-On operation of the NetBackup Administration Console on the host where the console runs. The NetBackup Administration Console cleans these files when an exit function is performed, so the directory does not always contain temporary files. However, if a system crash were to occur, any files in the directory may be left behind. With the console shutdown, you can delete these files safely with no data loss.

NetBackup also creates cached certificates for client and server NetBackup applications. These files reside within the /.vxss directory. These files typically have a name that is consistent with a DNS entry for a network interface, as in machine.company.com. Example directory entries are as follows:

```
/usr/openv/var/vxss/credentials/machine.company.com
/usr/openv/var/vxss/credentials/dhcp
```

These files are created with the command `bnpbat -LoginMachine`. If you plan to reinstall NetBackup on the same computer at a later date, do one of the following:

- Preserve the certificates in the vxss/credentials directory.
- If you do not preserve the certificates, you must provide the computer identity password as originally set on the Root+AB broker. As an alternative, you can reset the password on the Root+AB broker when you reinstall.

For more information on Root+AB brokers, see the NetBackup Security and Encryption Guide.

http://www.symantec.com/docs/DOC5332

For more information on NetBackup Access Control and how to remove it, see the NetBackup Security and Encryption Guide.

http://www.symantec.com/docs/DOC5332
About NetBackup server software removal on Windows systems

When you remove NetBackup server software, the process deletes the VERITAS/NetBackup directories from the server.

You can remove NetBackup server software in the following ways:

- Remove server software, configuration, and catalog information.
- Remove server software and save NetBackup configuration and catalog information.
  If you intend to reinstall NetBackup, use this procedure to save the configuration, catalog, and log file information before you remove NetBackup.

Note: After an uninstall, some registry and some directory information remain on a Windows computer. This behavior is by design, as these files may be in use by either the NetBackup Authentication Service or the NetBackup Authorization Service.

See “Removing NetBackup server software on Windows systems” on page 135.

Removing NetBackup server software on Windows systems

Use the following procedure to remove NetBackup server software and NetBackup configuration and catalog information.

To remove NetBackup server software and NetBackup configuration and catalog information

1. If the NetBackup Administration Console is open, close it.
   If a console session is open when you try to remove NetBackup, a failure may occur that forces you to restart this procedure.

2. Select Start > Settings > Control Panel.

3. On the Control Panel window, for Windows 2008 and later, click Programs and Features.

4. On the Currently Installed Programs list, click Symantec NetBackup.
5  Click **Remove**.

For Windows 2008/Vista and later systems, after you click **Yes** to continue, another dialog box appears to inform you that PBX is still running.

Symantec recommends that you click **Do not close applications. (A reboot will be required.)** to continue with NetBackup removal. PBX is stopped and restarted automatically as needed for removal.

6  Remove the NetBackup deduplication user directory as follows:

   In the **Documents and Settings** directory, delete the **purediskdbuser** directory.

Use the following procedure to remove NetBackup server software and save NetBackup configuration and catalog information.

**To remove NetBackup server software and save NetBackup configuration and catalog information**

1  If the NetBackup Administration Console is open, close it.

   If a console session is open when you try to remove NetBackup, a failure may occur that forces you to restart this procedure.

2  Select **Start > Settings > Control Panel**.

3  On the **Control Panel** window, for Windows 2008 and later, click **Programs and Features**.

4  In the **Currently Installed Programs** list, click **Symantec NetBackup**.

5  Click **Change**. This action lets you modify, repair, or remove NetBackup.

6  On the **Program Maintenance** dialog box, select **Remove**.

7  Clear the check mark next to **Remove all NetBackup Configuration, Catalog, and Log files** to disable this function. (The box is checked by default.)

8  Click **Next**.

9  If you enabled NetBackup Access Control, NetBackup placed several files on clients and servers. These files can be divided into the following categories:

   - **NetBackup application temporary files**
     - These files are removed with NetBackup.
User cache files exist in their home directories, as follows:

user\Local Settings\Application Data\VERITAS\NetBackup

Files are generated in the \NetBackup directory by a Single Sign-On operation of the NetBackup Administration Console on the host where the console runs. The NetBackup Administration Console cleans these files when an exit function is performed, so the directory does not always contain temporary files. If a system crash were to occur, however, any files in the directory may be left behind. With the console shutdown, you can delete these files safely with no data loss.

NetBackup also creates cached certificates for client and server NetBackup applications. These files reside within the \NetBackup directory. These files typically have a name that is consistent with a DNS entry for a network interface, such as machine.company.com. Example directory entries are as follows:

user\Local Settings\Application Data\VERITAS\NetBackup\pc.comp.com

user\Local Settings\Application Data\VERITAS\NetBackup\dhcp

These files are created with the command bpnbat -LoginMachine. If you plan to reinstall NetBackup on the same computer at a later date, do one of the following:

- Preserve the certificates in the \NetBackup directory.
- If you do not preserve the certificates, you must provide the computer identity password as originally set on the Root+AB broker. As an alternative, you can reset the password on the Root+AB broker when you reinstall. See the NetBackup Security and Encryption Guide.

http://www.symantec.com/docs/DOC5332
Remove the NetBackup deduplication user directory as follows:

---

**Note:** This step is necessary only if you upgraded to version 7.7 from a previous or earlier version of NetBackup.

---

In the **Documents and Settings** directory, delete the `purediskdbuser` directory.

### Removing NetBackup server software in a clustered environment

The following steps refer you to other documentation when you remove NetBackup software from clustered computers.

**To remove NetBackup from a clustered environment**

1. Follow the instructions in your cluster documentation for removing a group.
2. Remove NetBackup from each node in the cluster.

   See “To remove NetBackup server software and NetBackup configuration and catalog information” on page 135.

   No method exists to remove NetBackup from multiple nodes at the same time.

### Removing NetBackup LiveUpdate from Windows systems

NetBackup LiveUpdate and Symantec LiveUpdate share the same LiveUpdate agent. When you remove LiveUpdate, you can no longer distribute NetBackup updates automatically or other Symantec product updates.

Before you remove LiveUpdate, make sure that no other installed Symantec products use LiveUpdate.

Use the following procedure to remove LiveUpdate files on Windows systems.

**To remove NetBackup LiveUpdate on Windows systems**

1. Select **Start > Control Panel**.
2. On the **Control Panel** window, do one of the following:
   - For Windows XP and earlier, click **Add/Remove Programs**.
   - For Windows Vista/2008 and later, click **Programs and Features**.
3. Click on **LiveUpdate** and select **Remove**.
About removal of the Java Console state data from Windows servers and Windows clients

The NetBackup Java Console stores state data on a per-user basis. This information includes user preferences, toolbar locations, and related settings. After you uninstall the NetBackup Java Console, remove the state data by deleting the following folder:

```
USERPROFILE_DIR\Veritas\Java\JAVA_VERSION
```

- For roaming user profiles, `USERPROFILE_DIR` is `%APPDATA%`.
- For local user profiles on Windows XP, and earlier, `USERPROFILE_DIR` is `%USERPROFILE%\Local Settings`.
- For local user profiles on Windows 2008/Vista, and later, `USERPROFILE_DIR` is `%LOCALAPPDATA%`.
- `JAVA_VERSION` is a six-digit NetBackup version number. For example, NetBackup version 7.5 with no upgrades applied would be `750000`.

Example:

On a Windows 2008 system with the 7.7 NetBackup Java Console previously installed, and a local user profile policy, the Java Console state folder exists at `%LOCALAPPDATA%\Veritas\Java\770000`.
Removing NetBackup client software

This chapter includes the following topics:

- About NetBackup software removal on UNIX/Linux clients
- Removing NetBackup from UNIX/Linux clients
- Removing NetBackup Windows client software

About NetBackup software removal on UNIX/Linux clients

Use the following guidelines when you remove NetBackup from UNIX/Linux clients:

When you remove NetBackup client software, PBX is not removed. You must remove PBX manually. The client software removal procedure in this document includes a step that describes how to perform this task.

Warning: Do not remove PBX if your client uses other Symantec software products that require PBX to run.

Removing NetBackup from UNIX/Linux clients

Use the following procedure to remove all NetBackup client software components from a UNIX/Linux client.
To remove NetBackup software from a UNIX/Linux client

1. Log in to the client system as the root user.

2. Stop the NetBackup daemons by entering the following command:
   
   `/usr/openv/netbackup/bin/bp.kill_all`

3. Identify any installed add-on products by using the following command:
   
   *AIX*: `lslpp -L`
   
   *HP-UX*: `swlist`
   
   *Linux*: `rpm -qa`
   
   *Solaris*: `pkginfo`

   Three add-on products can be installed on the client. They are:
   
   - `SYMCfrnbclt`
   - `SYMCjanbc1t`
   - `SYMChzbclt`

   Remove any add-on products found.

4. To unregister NetBackup from the VxUL master configuration that is stored in the `/etc/vx/vrtslog.conf` file, run the following command:
   
   `/usr/openv/netbackup/bin/vxlogcfg -r -p 51216`

   The `-p` option specifies the product ID, which is 51216 for NetBackup.

5. To unregister all NetBackup products with LiveUpdate, enter the following command:
   
   `/usr/openv/netbackup/bin/nblu_registration -r`

6. For the clients that support the PureDisk agent, remove all PureDisk files with the following command:
   
   `/opt/pdde/pddeuninstall.sh -forceclean`
7 For the clients that support the NetBackup-Java Display Console, remove the console with the appropriate command as follows:

- **AIX**
  
  `installp -u SYMCnbjava`

- **HP-UX**
  
  `swremove SYMCnbjava`

- **Linux**
  
  `rpm -e SYMCnbjava`

- **Solaris**
  
  `pkgrm SYMCnbjava`

8 For the clients that support the NetBackup Java Runtime Environment (JRE), remove JRE with the appropriate command as follows:

- **AIX**
  
  `installp -u SYMCnbjre`

- **HP-UX**
  
  `swremove SYMCnbjre`

- **Linux**
  
  `rpm -e SYMCnbjre`

- **Solaris**
  
  `pkgrm SYMCnbjre`

9 For native package clients, remove the NetBackup client by using the appropriate commands as follows:

- **AIX**
  
  `installp -u SYMCnbclt`

- **HP-UX**
  
  `swremove SYMCnbclt`

- **Linux**
  
  `rpm -e SYMCnbclt`

- **Solaris**
  
  `pkgrm SYMCnbclt`
10 Remove PBX with the appropriate native command as follows:

**Note:** Do not remove PBX if your client uses other Symantec software products that require PBX to run.

<table>
<thead>
<tr>
<th>OS</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AIX</strong></td>
<td><code>installp -u VRTSpbx</code></td>
</tr>
</tbody>
</table>
| **Debian**     | `/opt/VRTSpbx/bin/vxpbx_exchanged stop`  
                   `rm -rf /opt/VRTSpbx`  
                   `rm -rf /etc/vx/VxICS` |
| **FreeBSD**    | `pkg_delete VRTSpbx`     |
| **HP-UX**      | `swremove VRTSpbx`       |
| **Linux**      | `rpm -e VRTSpbx`         |
| **Macintosh OS X** | `/opt/VRTSpbx/bin/vxpbx_exchanged stop`  
                   `rm -r /Library/Receipts/VRTSpbxApp.pkg`  
                   `rm -r /opt/VRTSpbx`  
                   `rm -r /etc/vx/VxICS`  
                   `rm -r /usr/share/man/man1/pbxcfg.1`  
                   `rm -r /Library/StartupItems/vxpbx_exchanged` |
| **Solaris**    | `pkgrm VRTSpbx`          |

11 For all clients, navigate to the `/usr/openv` directory and proceed as follows:

**Warning:** The `rm -f /usr/openv` command also removes any add-on products that are installed on this computer.

- If `/usr/openv` is the actual directory, run the following command:
  `rm -rf /usr/openv`
- If `/usr/openv` is a symbolic link to that directory, run the following commands:
  `cd /usr/openv`
  `pwd`
  `ls`
Warning: Before you continue, make sure that you are at the correct location and verify that the subdirectories are what you expect them to be. To help prevent removing the wrong directories, the previous commands verify your current location and list the files in that directory. After you verify the directory location and its contents, remove the directory with the next commands.

```
rm -rf *
rm -f /usr/openv
```

12 For Linux systems only:

If you modified the startup and the shutdown scripts, run the following command:

```
/sbin/chkconfig --del netbackup
```

See “About NetBackup startup and shutdown scripts” on page 112.
13 Remove the following startup scripts:

**AIX**

/etc/rc.netbackup.aix

**FreeBSD**

/usr/local/etc/netbackup  
/usr/local/etc/rc.d/S77netbackup.sh

**HP-UX**

/sbin/init.d/netbackup  
/sbin/rc1.d/K01netbackup  
/sbin/rc2.d/S77netbackup

**Linux Debian**

/etc/init.d/netbackup  
/etc/rc0.d/K01netbackup  
/etc/rc1.d/K01netbackup  
/etc/rc2.d/S95netbackup

**Linux Red Hat**

/etc/rc.d/init.d/netbackup  
/etc/rc.d/rc0.d/K01netbackup  
/etc/rc.d/rc1.d/K01netbackup  
/etc/rc.d/rc2.d/S77netbackup  
/etc/rc.d/rc3.d/S77netbackup  
/etc/rc.d/rc5.d/S77netbackup  
/etc/rc.d/rc6.d/K01netbackup

**Linux SUSE**

/etc/init.d/netbackup  
/etc/init.d/rc0.d/K01netbackup  
/etc/init.d/rc2.d/S77netbackup  
/etc/init.d/rc3.d/S77netbackup  
/etc/init.d/rc5.d/S77netbackup  
/etc/init.d/rc6.d/K01netbackup

**Macintosh OS X**

/Library/StartupItems/netbackup/Resources/netbackup  
/Library/StartupItems/netbackup/StartupParameters.plist  
/Library/StartupItems/netbackup/netbackup
Other clients

/etc/init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S77netbackup

14 For AIX systems only:

- In the /etc/inittab file, remove the following NetBackup entry:
  /etc/rc.netbackup.aix

- In the /etc/rc.shutdown file, remove the following line:
  /etc/rc.netbackup.aix stop

15 Remove Symantec LiveUpdate components as follows:

- First, examine the following file to see if NetBackup is the only product that
  uses LiveUpdate:
  /etc/Product.Catalog.JavaLiveUpdate

- If no entries in the file contain the string NetBackup, run the following
  commands:
  /opt/Symantec/LiveUpdate/uninstall.sh -a
  rm -f /etc/Symantec.conf

Note: Before you remove the following product catalog file, make sure that
it is empty. The empty file size is equal to 0 bytes. If the product catalog
file is not empty, do not remove it because other Symantec products still
require it.

  rm -f /etc/Product.Catalog.JavaLiveUpdate

16 To remove the NetBackup-Java application state data for the root account, run
the appropriate command as follows:

Warning: Do not insert a space between the slash character (/) and the period
or the dot character (.) of "/.veritas". A space between these characters
removes all of your files from the root level and beyond.

- To remove the NetBackup-Java application state data for the root account
  for all releases, run the following command:

  /bin/rm -rf /.veritas
To remove the NetBackup-Java application state data for the root account for a specific release, run the following command:

`/bin/rm -rf ~/.veritas/java/<version>`

Where `<version>` is the six-digit NetBackup version number. For example, NetBackup version 7.7 with no upgrades applied would be entered as `770000`.

17 Inform NetBackup-Java users that they can remove their $HOME/.veritas directory and portions of the $HOME/.veritas/java directory.

The $HOME/.veritas/java and $HOME/.veritas directories contain application state information, that is saved when the user exits NetBackup-Java applications. The saved information includes table column order and size. The process removes this directory for the root user only.

The common subdirectory in $HOME/.veritas/java/.userPrefs/vrts can be removed.

18 If you enabled NetBackup Access Control, NetBackup created new files on the clients and the servers that can be divided into the following categories:

- Individual user files
  Individual user cache files exist in their home directories (for example, in $HOME/.vxss). Inform those users that they can remove the $HOME/.vxss directory.

- NetBackup application temporary files
  NetBackup temporary files are removed with NetBackup.

---

**Removing NetBackup Windows client software**

Use the following procedure to remove NetBackup Windows client software.

**To remove NetBackup Windows client software**

1 If it is open, close the NetBackup Backup, Archive, and Restore interface.

2 Open the Windows **Control Panel** and for Windows 2008 and later, click **Programs and Features**.

3 Select **Symantec NetBackup Client**.

4 Click **Remove**.
Reference

This chapter includes the following topics:

- About the NetBackup Java Runtime Environment
- Using NetApp disk arrays with Replication Director
- Security updates to the NetBackup database

About the NetBackup Java Runtime Environment

When you install NetBackup server software, a customized version of the Java Runtime Environment (JRE) is installed. NetBackup also installs this customized version of the JRE when you install the Remote Administration Console. You do not need to install or update this JRE separately. You can only update this version of the JRE through NetBackup maintenance updates. You may have additional versions of the JRE installed on your system for different applications. The NetBackup JRE does not interfere with these other installations. The NetBackup JRE does not provide integration with web browsers and does not allow Java Applets or Web Start to run. For that reason, the NetBackup JRE cannot be used in a browser-based attack that uses Java Applet or Web Start vulnerabilities.

For more information, see TECH50711.
http://www.symantec.com/docs/TECH50711

Using NetApp disk arrays with Replication Director

Replication Director can replicate snapshots on a NetApp disk array in two different situations:

- In non-cluster mode: 7-mode is used to replicate snapshots on NAS and SAN. The plug-in must be installed on the OnCommand Unified Manager (OCUM) server (Figure 11-1).
In cluster-mode: Clustered Data ONTAP (cDOT) is used to replicate snapshots between storage virtual machines (SVMs or vServers). Support is for NAS only. The plug-in must be installed on either a Windows or a Linux computer other than the OCUM server, the master server, or any media servers (Figure 11-2).

Both modes support the same topologies.

Table 11-1 describes the association between NetBackup versions and the NetApp plug-ins.

<table>
<thead>
<tr>
<th>NetBackup version</th>
<th>NetApp plug-in version</th>
<th>Description</th>
<th>Ratio of master server to OCUM server</th>
<th>Supported policy types</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.7</td>
<td>1.1</td>
<td>Provides 7-mode support for all NetBackup 7.7 Replication Director features.</td>
<td>One master server supports many OCUM servers. The plug-in must be installed on the OnCommand Unified Manager (OCUM) server.</td>
<td>MS-Windows, Standard, NDMP, VMware, Oracle</td>
</tr>
<tr>
<td>2.0</td>
<td></td>
<td>Provides cDOT support.</td>
<td>One master server supports many OCUM servers. The plug-in must be installed on either a Windows or a Linux computer other than the OCUM server, the master server, or any media servers.</td>
<td>MS-Windows, Standard, NDMP, VMware, Oracle</td>
</tr>
<tr>
<td>7.6</td>
<td>1.1</td>
<td>NetApp Data ONTAP 7-Mode support for all of NetBackup 7.6 Replication Director features.</td>
<td>One master server to many OCUM servers</td>
<td>MS-Windows, Standard, NDMP, VMware, Oracle</td>
</tr>
</tbody>
</table>

**Note:** You must upgrade the entire NetBackup environment before upgrading the plug-in. Upgrade all master servers, media servers, clients, and any hosts which communicate with the plug-in.
Figure 11-1  Communication between NetBackup and the NBUPlugin for 7-mode NetApp OnCommand Unified Manager
NBUPlugin for 7-mode
NFS/CIFS
NetBackup
client 2
NetBackup
client 1
NetBackup 7.7 master server
NetBackup 7.7 media server
Communicate via OpenStorage Technology plug-in
NetApp OnCommand Unified Manager
NBUPlugin for 7-mode
SnapMirror
SnapVault
7-mode Primary
7-mode Secondary
Determining the version of the plug-in

To determine the NBUPlugin version, look for the following version file on the system where the NBUPlugin is installed:

**On Windows:** `Install_path\Program Files\Netapp\NBUPlugin\version.txt`

**On UNIX:** `/usr/NetApp/NBUPlugin/version.txt`

The contents of the file lists the product name, the build date, and the NBUPlugin version. If more than one plug-in is installed, both are listed.
Upgrading the plug-in

If upgrading the NetApp Plug-in for Symantec NetBackup, make sure that all storage lifecycle policy jobs that use the old plug-in are complete before upgrading.

To determine whether all of the jobs that are associated with a storage lifecycle policy are complete, in process, or not started, use the following command:

On Windows: C:\Program Files\VERITAS\NetBackup\bin\admincmd>nbstlutil.exe stlilist -U

On UNIX: /usr/openv/netbackup/bin/admincmd/nbstlutil stlilist -U

Security updates to the NetBackup database

As a part of security changes in NetBackup, Symantec may make changes to your NetBackup (NBDB) database password. If you changed the password on the NetBackup database from the default value, no changes to the password are made. Any existing NetBackup databases which still have the default password are updated with a new, randomly generated password. All new installations of NetBackup have a randomly generated password assigned to the NetBackup database for improved security. This password is not provided to the user during installation or upgrade. You can use the nbdb_admin command to change this randomly generated password. See the Symantec NetBackup Commands Reference Guide for more information about the nbdb_admin command.
A
about
  Backup Policy Wizard 121
  client installation 83
  client installation on Linux 95
  client installation on UNIX 95
  client installation on Windows 84
  license key entry 25
  Linux client installation methods 97
  mounting NetBackup media 36
  NetBackup 7.x Upgrade Portal 123
  NetBackup catalog backup configuration 120
  NetBackup Linux client removal 140
  NetBackup Remote Administration Console for Windows 76
  NetBackup server configuration 114
  NetBackup UNIX client removal 140
  NetBackup-Java Administration Console 80
  preinstall checker 21
  push client software 48
  remote installation methods for Linux clients 100
  remote installation methods for UNIX clients 100
  startup and shutdown scripts 112
  storage device configuration 20
  Symantec Operations Readiness Tools 11
  the preinstallation Environment Checker 55
  UNIX client installation methods 97
  Windows client installation methods 84
  Windows client system requirements 84
about NetBackup removal
  on UNIX systems 125
access control
  remove files 137
add remote servers
  to administer from NetBackup Remote Administration Console 79
add-on products
  install 50
adding Linux clients 106
adding UNIX clients 106
administer from NetBackup Remote Administration Console
  add remote servers 79
authentication certificates. See security certificates
B
backup
  online, hot catalog 120
backup policies
  guidelines for creating 121
backup policy
  backup types 121
  create 121
Backup Policy Wizard
  about 121
backup types
  backup policy 121
barcode rules
  cleaning media 120
bp.conf file
  installation script 35
bpplclients command 110
  create client list 110
C
catalog backup configuration
  NetBackup wizards 120
certificates. See security certificates
cleaning media
  barcode rules 120
client installation
  about 83
  methods for Linux 97
  methods for UNIX 97
  methods for Windows 84
client installation methods
  for remote Linux clients 100
  for remote UNIX clients 100
client installation on Linux
  about 95
client installation on UNIX
about 95
client installation on Windows
about 84
client software
install locally on Windows 87
client type software
install on master server 49
client_config script 102, 105
clients
about remote installation methods for Linux
clients 100
about remote installation methods for UNIX
clients 100
adding after initial install 106
loading onto server 106
pushing software to 106
upgrading after server upgrades 108
cluster
private network 70
Cluster Administrator console
verify Windows cluster installation or upgrade 73
cluster group
configuration 70
install new 69
cluster group name 69
cluster installation and upgrade
requirements 58
cluster installations
post-installation tasks 72
cluster installations or upgrades
verify Windows 73
commands
bpplclients 110
compatibility
license keys 25
NetBackup-Java 96
configuration
master and media servers 114
NetBackup servers 114
configuration guidelines
NetBackup Enterprise servers 114
configure
cluster group 70
NetBackup catalog backup 120
NetBackup storage devices 117
NetBackup volumes 119
Windows client 94
configure catalog backup
guidelines 120
configure storage devices
for the operating system 20
configure window manager
for Java interface 50
NetBackup-Java compatible platforms 50
continue installation
after master server installation 44
create
backup policy 121
create client list
bpplclients command 110
D
define
storage units 119
device configuration
guidelines 118
NetBackup wizards 117
Domain Name Service (DNS) 32
E
Environment Checker
about 55
run before installation 56
ESD images
for NetBackup 19
F
frequently asked questions
license keys 27
ftp method
install UNIX client 102
remote UNIX client installation 102
G
general requirements
UNIX server installation 32
Getting Started
NetBackup wizards 114
guidelines
configure catalog backup 120
device configuration 118
for creating backup policies 121
robot inventory 120
standalone drive inventory 120
gunzip command
required for installation 32
UNIX client installation 96
gzip command
required for installation 32
UNIX client installation 96

H
hosts file 32
how to install
sequence for new installations 21
how to start
NetBackup Administration Console 116

I
inetd.conf file
installation script 35
install
add-on products 50
Java Windows Administration Console 80
NetBackup Remote Administration Console 76
new cluster group 69
install locally
client software on Windows 87
install locally on Windows
server software 60
install multiple versions of NetBackup Administration Console
restrictions and guidelines 81
install multiple versions on Windows
NetBackup-Java Administration Console 81
install NetBackup clients
locally 98
install on clustered Windows environments
server software 60
install on master server
client type software 49
install remotely
Windows client software 87
install remotely on Windows
server software 60
install silently
Windows client 93
install UNIX client
ftp method 102
rsh method 101
sftp method 105
ssh method 104
install_client_files script 104–105
installation
methods for Linux clients 97
methods for UNIX clients 97
methods for Windows clients 84
UNIX clients locally 98
installation guidelines
HP-UX systems 34
Solaris systems 34
UNIX clusters 34
installation restrictions
Windows client 84
installation script
bp.conf file 35
inetd.conf file 35
server installation 35
services file 35
inventory
robot 120
standalone drive 120
IPv4 clusters 69
IPv6 clusters 69

J
Java Console
installing multiple versions 80
removing multiple versions 80
Java interface
configure window manager 50
Java Windows Administration Console
install 80

L
license key entry
about 25
license keys
compatibility 25
frequently asked questions 27
requirements 24
Linux
mount NetBackup DVD 37
Linux client
about removing PBX 140
Linux client installation methods
about 97
Linux clients
installation methods 97
remove NetBackup 140
Linux systems
server installation requirements 31
loading client types onto server 106
local installation
  UNIX client 97
  Windows client 85

M
master and media servers
configuration 114
master server
  continue installation after 44
  install client type software 49
  software installation 38
media kit
description of contents 18
media server
  software installation 44
methods
  for Linux client installation 97
  for UNIX client installation 97
  for Windows client installation 84
mixed version support
  NetBackup 7.x 11
mount DVD
  NetBackup installation 36
mount NetBackup DVD
  Linux 37
  UNIX 37

N
NBUPPlugin
determining the version 151
upgrading 152
NetBackup
  ESD images 19
  how to install 21
  media kit contents 18
  port numbers 54
NetBackup 7.x
  mixed version support 11
NetBackup Access Control
  remove files 133
NetBackup Administration Console 80
  how to start 116
NetBackup catalog 53
NetBackup catalog backup configuration
  about 120
NetBackup client software
  add a UNIX client type 106
  install locally 98
NetBackup DVDs 18
NetBackup Electronic Software Distribution (ESD) images 18
NetBackup Enterprise servers
  configuration guidelines 114
NetBackup installation
  mount DVD 36
NetBackup LiveUpdate
  remove from Windows systems 138
NetBackup media
  about mounting 36
NetBackup media kit
  about 18
NetBackup Product Improvement Program 22
NetBackup Remote Administration Console
  configure server lists for 78
  installation 76
NetBackup Remote Administration Console for Windows
  about 76
NetBackup scripts
  startup and shutdown 112
  UNIX 112
NetBackup server configuration
  about 114
NetBackup server software
  about removal on UNIX 125
NetBackup servers
  configuration 114
  remove software 135
NetBackup storage devices
  configure 117
NetBackup upgrades 123
NetBackup volumes
  configure 119
NetBackup wizards
  backup policy configuration 121
  catalog backup configuration 120
  device configuration 117
  Getting Started 114
  volume configuration 119
NetBackup-Java
  compatibility 96
NetBackup-Java Administration Console
  about 80
  install multiple versions on Windows 81
NetBackup-Java Administration Console (continued)
remove multiple versions on Windows 82
NetBackup-Java compatible platforms
  configure window manager 50
Network Information Service (NIS) 32
new installations
  sequence 21
NTFS partition 53, 86

O
online, hot catalog
  backup 120
operating system
  configure storage devices for 20

P
PBX
  about removal from Linux clients 140
  about removal from UNIX clients 140
  remove 126
  remove from non-Solaris 126
ping command 53
plug-ins
  NetApp 149
  upgrading from NetApp 152
post-installation tasks
  cluster installations 72
preinstall checker
  about 21
preinstallation
  about the Environment Checker 55
  running the Environment Checker 56
private network
  cluster 70
public network 70
push client software
  about 48
push installation
  UNIX client 98
  pushing client software 106

R
recommended installation procedures
  Symantec Operations Readiness Tools 12
recommended upgrade procedures
  Symantec Operations Readiness Tools 16
remote
  about installation methods for Linux clients 100
  (continued)
  about installation methods for UNIX clients 100
remote installation
  about methods for Linux clients 100
  about methods for UNIX clients 100
  UNIX client 98
  Windows client 86
remote UNIX client installation
  ftp method 102
  rsh method 101
  sftp method 105
  ssh method 104
remove
  server software in clusters 138
  Windows Java Console 139
  Windows server software 135
remove files
  access control 137
remove from Windows systems
  NetBackup LiveUpdate 138
remove multiple versions on Windows
  NetBackup-Java Administration Console 82
remove NetBackup
  from UNIX servers 126
  Linux clients 140
  UNIX clients 140
remove NetBackup software
  about Linux clients 140
  about UNIX clients 140
  Windows client 147
remove software
  NetBackup servers 135
requirements
  cluster installation and upgrade 58
  license keys 24
requirements for server installation
  Red Hat Linux 33
restrictions and guidelines
  install multiple versions of NetBackup
  Administration Console 81
robot
  inventory 120
robot inventory
  guidelines 120
robot types
  locate supported 21
rsh method
  install UNIX client 101
  remote UNIX client installation 101
S

scripts
  client_config 102, 105
  install_client_files 104
  install_client_files using ftp 102
  install_client_files using sftp 105
  install_client_files using ssh 104

security certificates
  about 23
  for cloud storage 23

sequence
  for installations 21

server configuration
  Windows 2008 53

server installation
  installation script 35
  requirements for Red Hat Linux 33

server installation requirements
  Linux systems 31
  UNIX systems 31
  Windows systems 52

server lists
  configure for NetBackup Remote Administration Console 78

server software
  install in clustered Windows environments 60
  install locally on Windows 60
  install remotely on Windows 60
  remove in clusters 138

server software removal
  on UNIX systems 125

servers
  silent installation on Windows 73

services file
  installation script 35

sftp method
  install UNIX client 105
  remote UNIX client installation 105

silent installation on Windows servers 73

silent Installations
  Windows client 86

software installation
  master server 38
  media server 44

SORT
  Symantec Operations Readiness Tools 11–12, 16

ssh method
  install UNIX client 104
  remote UNIX client installation 104

standalone drive
  inventory 120

standalone drive inventory
  guidelines 120

startup and shutdown
  NetBackup scripts 112
  startup and shutdown scripts
    about 112

storage device configuration
  about 20

storage units
  define 119

subnet mask 69

supported robot types
  locate for this release 21

Symantec Operations Readiness Tools (SORT)
  about 11
  recommended installation procedures 12
  recommended upgrade procedures 16

system requirements
  Windows clients 84

U

uninstall
  Windows Java Console 139
  Windows server software 135

UNIX
  mount NetBackup DVD 37
  NetBackup scripts 112

UNIX client
  about removing PBX 140
  local installation 97
  push installation 98
  remote installation 98

UNIX client installation methods
  about 97

UNIX clients
  installation methods 97
  installing locally 98, 106
  remove NetBackup 140

UNIX server installation
  general requirements 32

UNIX servers
  remove NetBackup from 126

UNIX systems
  server installation requirements 31
upgrade clients
   after upgrading servers 108
upgrade portal
   about NetBackup 7.x 123
upgrade to NetBackup 7.x
   about the upgrade portal 123
user permissions
   user-directed operations 84
Windows client 84
user-directed operations
   user permissions 84

V
verify
   Windows cluster installations or upgrades 73
verify Windows cluster installation or upgrade
      Cluster Administrator console 73
versions, determining NetApp NBUPlugin 149
virtual host name 69
virtual IP address 69
volume configuration
      NetBackup wizards 119

W
Windows
   clustered install 60
   local install 60
   remote install 60
   remove or uninstall Java Console 139
   remove or uninstall server software 135
   remove or uninstall software 135
   silent install 73
   verify cluster installation 73
Windows 2008
   server configuration 53
Windows client
   configure 94
   install silently 93
   installation restrictions 84
   local installation 85
   remote installation 86
   remove NetBackup software 147
   silent installation 86
   user permissions 84
Windows client installation methods
   about 84
Windows client software
   install remotely 87
Windows client system requirements
   about 84
Windows clients
   installation methods 84
   system requirements 84
Windows systems
   cluster installation and upgrade requirements 58
   server installation requirements 52